## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>WELCOME TO SMART CRAPS</strong></td>
<td>3</td>
</tr>
<tr>
<td>What is Smart Craps?</td>
<td>5</td>
</tr>
<tr>
<td>Resources on Craps</td>
<td>7</td>
</tr>
<tr>
<td>How to play Craps</td>
<td>8</td>
</tr>
<tr>
<td><strong>PRODUCT HISTORY AND PLATFORMS</strong></td>
<td>21</td>
</tr>
<tr>
<td>Registering and purchasing</td>
<td>23</td>
</tr>
<tr>
<td><strong>THE THEORY OF DICE CONTROL</strong></td>
<td>24</td>
</tr>
<tr>
<td>SRR - Seven to Rolls Ratio</td>
<td>27</td>
</tr>
<tr>
<td>Pro Test</td>
<td>29</td>
</tr>
<tr>
<td>Pro 1 Test</td>
<td>31</td>
</tr>
<tr>
<td>Pro 2 Test</td>
<td>34</td>
</tr>
<tr>
<td>Pro 3 Test</td>
<td>36</td>
</tr>
<tr>
<td>Pro Test in Practice</td>
<td>37</td>
</tr>
<tr>
<td>Pro Test Player Edge</td>
<td>45</td>
</tr>
<tr>
<td><strong>HOW SMART CRAPS WORKS</strong></td>
<td>52</td>
</tr>
<tr>
<td>Simulation settings</td>
<td>56</td>
</tr>
<tr>
<td>Craps Game Settings</td>
<td>59</td>
</tr>
<tr>
<td>Betting Systems</td>
<td>64</td>
</tr>
<tr>
<td>Flat Betting Module</td>
<td>67</td>
</tr>
<tr>
<td>Script Betting Module</td>
<td>70</td>
</tr>
<tr>
<td>Shooter Settings</td>
<td>82</td>
</tr>
<tr>
<td>Pro Test Summary</td>
<td>89</td>
</tr>
<tr>
<td>Table Settings</td>
<td>91</td>
</tr>
<tr>
<td>Pro Test Dice Set Optimizer</td>
<td>96</td>
</tr>
<tr>
<td>Risk of Ruin calculator</td>
<td>102</td>
</tr>
</tbody>
</table>
Welcome to Smart Craps

Thank you for using Smart Craps from DeepNet Technologies, the most advanced simulator and player improvement program for the casino game of craps. If you have any questions not answered in these online help pages, please visit our web site for our up-to-date FAQ section (frequently asked questions), and further assistance: www.SmartCraps.com

Click on the 'Contents' button above this page to see a complete list of the help topics available for Smart Craps. Also, you can press 'F1' in any dialog in the software to get specific context sensitive help.

Here is a quick jump guide to the most important sections:

**What is Smart Craps? » Page 5**
- A brief description of this program, and what it does.

**The Theory of Dice Control » Page 24**
- A brief introduction to dice control in the game of craps. Explains the basic physical concepts.

**Pro Test - a better dice control metric » Page 29**
- Pro Test is the foundation of Smart Craps. It is a new statistical approach to dice control in the game of craps.

**How Smart Craps Works » Page 52**
- A brief introduction to the settings and main features in Smart Craps.

**Creating a Simulation Files » Page 133**
- A step-by-step tutorial on creating a simulation and using most Smart Craps features.

**Pro Test Dice Set Optimizer » Page 96**
- A brief introduction to the settings and main features in Smart Craps.

**Default Example Files » Page 118**
- A brief introduction to the settings and main features in Smart Craps.
For help using this help system, press 'F1' now. The '<<' and '>>' symbols along the top of this window can be used to scroll forwards and backwards through the related sequence of help topics. Click on the 'Contents' button along the top for the main help index.

**Credits**

Our thanks go out to all the friends who helped out during the development of *Smarts Craps*. Especially Frank Scoblete, Dom 'Dominator' LoRiggio, and Henry Tamburin, for their early involvement and encouragement while the idea was just a notion. And many kudos to the invaluable Alpha and Beta Testers who helped find bugs and offer suggestions. Especially 'Stickman', 'Streetdog', Jan Trabandt, and George Henne.

**Copyright Notice**

Copyright©2005 DeepNet Technologies.

All rights reserved. Except for appropriate use in critical reviews or works of scholarship, the reproduction or use of this work in any form or by any electronic, mechanical, or other means now known or hereafter invented, including photocopying and recording, and in any information storage and retrieval system is forbidden without the written permission of DeepNet Technologies.
What is Smart Craps?

_Smart Craps_ is a software program crammed with features to help craps players get the greatest edge in the game. In particular, it helps _controlled shooters_ optimize their _dice sets_ and betting systems. Shooters can test different betting systems and levels of dice control.

Unlike blackjack and a few other casino games (such as some video poker games), craps cannot be beaten with mathematics and 'brain power' alone. In blackjack, we can learn an advanced card counting system to determine when we have a positive edge (based on the remaining cards in the shoe), and bet more accordingly. There is no similar strategy or system in craps: if you are using random rolls of the dice, you are bound to lose money in the long run, _no matter what betting strategy or system you use_. There are many scam books and resources that say you can make money simply by controlling your bets (in craps, blackjack, roulette, baccarat, etc.): this is _not_ what _Smart Craps_ is about!

**But...** this does _not_ mean the game of craps can't be beaten! The answer lies in _dice control_, the physical skill of manipulating the throws of the dice such that the average outcome is _not_ random, and sufficiently biased to produce a positive player edge given a particular betting strategy.

To get a positive player edge and win at craps (in the long run), you need to do three things:

1) Learn the physical skill of dice control.

2) Confirm, through mathematical tests of your rolls, that you have learned this skill and that you are rolling the dice and generating non-random results with statistical certainty.

3) Determine what positive player edge, if any, your level of dice control skill yields given a specific betting/playing strategy in craps.

_Smart Craps_ is all about steps two and three. Since dice control is a physical skill, not a pure mental skill like card counting in blackjack, you will not be able to learn and master it from a book or software program alone. See our Resources »Page 7 section for more information, web links, and books about learning the skill of dice control.

While many resources exist about dice control for the game of craps (step one above), very little has been provided to help players with steps two and three: converting a mastered dice control skill into the maximum player edge possible. Some books will talk about _dice sets_, for example, but how do we know these are the _best_ dice sets possible, given any particular bet or betting strategy? How much
Mathematical edge is a player getting, given a certain set? What impact do different bets have, or betting on shooters with unknown levels of dice control skill? *Smart Craps* is the first program to let you answer these questions through the most advanced craps simulator, and powerful tools such as our dice set optimizer.
Resources on Craps

This documentation assumes that you are familiar with the game of craps, and the rudimentary idea of dice control (but you don’t have to be a skilled dice setter yet… you may be using Smart Craps to assess the potential of dice control).

There are a number of web sites, books and courses about dice setting and dice control for the game of craps. Included below is a small selection of a few of these:

http://www.GoldenTouchCraps.com
A fantastic hands-on training course for learning dice control. Taught by leading gambling experts such as Frank Scoblete. Dice control cannot be learned simply by reading a book… that would be like learning to juggle without ever picking up the balls! Consider this 'best of class' course with no nonsense or phony 'systems'.

The Craps Underground
By Frank Scoblete (Bonus Books). A fun and very entertaining look at dice control from the inside. Learn what it is like, through Scoblete's incredible stories.

Craps - Take the Money and Run
By Henry Tamburin (Research Services Unltd). A fantastic introduction to the game of craps, covering the rules, bets, and basic strategies.

Beat the Craps Out of the Casinos: How to Play Craps and Win!
By Frank Scoblete (Bonus Books): The classic, best-selling craps book of all time, now updated with new chapters. Introduces the Captain and discusses his revolutionary methods of play, including the 5-Count, the Supersystem and Pushing the House. You’ll also read about the Captain’s Crew of high rollers and the remarkable lady known as “the Arm” – the precision shooter who became a legend in Atlantic City craps circles.

Get the Edge at Craps
By 'Sharpshooter' (Bonus Books). An excellent and thorough treatment on dice control. Includes excellent mathematical sections on SRR and edge calculations.
How to play Craps

This section is excerpted from the book "Casino Gambling: Play Like a Pro in 10 Minutes or Less" by Frank Scoblete, with permission from the author (Bonus Books, $14.00).

Frank Scoblete: The #1 best-selling gaming author in America, Frank’s books and tapes have sold over 2 million copies. Frank writes for over 40 magazines, newspapers and websites in America, Europe, Canada, and the Islands, including Casino Player, Jackpot, Casino Magazine in the Memphis Commercial Appeal, Midwest Gaming and Travel, Gaming South, Access and www.scoblete.com. He has appeared on and been a consultant for many television networks including the Discovery Channel, CNN, TBS, The Travel Channel, ABC, Walter Cronkite, and A&E. He has done consulting work for IGT, Mikohn Gaming and Silicon Gaming, among others. He is also a commentator on The Goodtimes Show on WMC, 790 AM in Memphis. His newest books are The Golden Touch Dice Control Revolution co-authored with Dominator, The Craps Underground: The Inside Story of How Dice Controllers Have Won Millions from the Casinos! and Casino Gambling: Play Like a Pro in 10 Minutes or Less! Frank also wrote the new Golden Touch Dice Control DVD. (Seminars: 5-Count Craps and Rhythmic Rolling: How to Get the Edge; Our Wild and Crazy Adventures in the Casinos with Jean Scott; Slot Machine Myths and Facts; Hands-on Instruction in Blackjack and Dice Throwing).

Craps

The most exciting, yet the most intimidating game in the casino, craps is witnessing a surge of popularity due to the belief that some shooters can change the odds of the game to favor the players by reason of their “rhythmic rolling” or “precision shooting” (I believe! I believe!). Be that as it may, the majority of craps players play the game so poorly that no amount of “dice control” can overcome the huge house edges that they are giving the casinos. And that doesn’t have to be, because at its purist, craps is a very simple game with a very small house edge on its better bets.

Despite its appearance the game is as easy as 1-2-3 to learn. The Pass Line that goes around the whole table and the Don’t Pass Line that tends to mirror it are the two basic bets of craps.

1. The game starts with the shooter placing one or the other of these bets. Since most players are “right bettors,” that is, they bet the Pass Line, let’s look at the game from the perspective of the Pass Line. The shooter places a bet on the Pass Line. He is given the dice. The
shooter now rolls the dice. If he rolls a 7 or 11, the Pass Line bettors win even money -- i.e., you bet $10, you win $10. The Don't Pass bettors lose. However, if the shooter rolls a 2, 3 or 12, the Pass Line bettors lose and, on the 2 or 3, the Don't Pass bettors win; while on the 12, the Don't Pass bettors push, neither winning nor losing.

2. If the shooter rolls any one of the following numbers: 4, 5, 6, 8, 9, or 10; this number becomes the point. For the Pass Line bettor to win, the shooter must roll that number again before he rolls a 7. The reverse holds true for the Don't Pass bettor. If a 7 is rolled before the point, the Don't Pass bettor wins.

3. If the shooter “sevens out,” the dice are passed on to the next shooter. If the shooter hits his point, he “comes out” again, just as in the above.

That’s the game, pure and simple.

Playing the Pass or Don’t Pass gives the casino an approximately 1.4 percent edge. However, the player can reduce the edge even more by taking advantage of the “Free Odds” bet option. Here’s an example of how this option works:

The 7 can be made six different ways with two dice. The 5 can be made four different ways with two dice. Thus, the odds of a 7 appearing in relation to a 5 are six ways to four ways or three to two. Once the shooter has established his point number (let’s keep it as the 5), the player has the option of placing an amount equal to (single odds), twice as much (double or 2X odds), three times as much (triple or 3X odds), five times as much (5X Odds), ten times as much (10X Odds), 20 times as much (20X Odds), or 100 times (100X Odds) or more, as his Pass Line bet in “odds” immediately behind it. The casino determines how much “odds” it will allow. Let’s analyze the bet based on double odds.

The point is 5 and you have $10 on the Pass Line. You can now place $20 in odds behind it. If the shooter rolls a 5, you will be paid even money for your $10 Pass Line bet and the true odds for the Odds bet -- thus, you would win $30 for your $20 Odds bet. The casino has no edge whatsoever on this bet in the long run. The Free Odds bet reduces the casino edge on the Pass Line as follows (the Don’t Pass is fractionally less):

<table>
<thead>
<tr>
<th>BET</th>
<th>CASINO EDGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double Odds</td>
<td></td>
</tr>
</tbody>
</table>
Pass Line with no odds 1.41%
Pass Line with 1X odds 0.85%
Pass Line with 2X odds 0.61%
Pass Line with 3X odds 0.47%
Pass Line with 5X odds 0.33%
Pass Line with 10X odds 0.18%
Pass Line with 20X odds 0.10%
Pass Line with 100X odds 0.02%

The true odds for the point numbers are as follows:

<table>
<thead>
<tr>
<th>Number</th>
<th>Ways to Make</th>
<th>Ways to Make Seven</th>
<th>Odds</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>3</td>
<td>6</td>
<td>2 to 1</td>
</tr>
<tr>
<td>5</td>
<td>4</td>
<td>6</td>
<td>3 to 2</td>
</tr>
<tr>
<td>6</td>
<td>5</td>
<td>6</td>
<td>6 to 5</td>
</tr>
<tr>
<td>8</td>
<td>5</td>
<td>6</td>
<td>6 to 5</td>
</tr>
<tr>
<td>9</td>
<td>4</td>
<td>6</td>
<td>3 to 2</td>
</tr>
<tr>
<td>10</td>
<td>3</td>
<td>6</td>
<td>2 to 1</td>
</tr>
</tbody>
</table>

Two other low-percentage bets are the *Come* and *Don’t Come* bets. These function in exactly the same way and have exactly the same house edges as the *Pass* and *Don’t Pass* bets. The only difference is that they are made after the point is established. Once the shooter has a point, you can place a bet in the large *Come* area on the layout or on the smaller *Don’t Come* area in the upper left and right hand corners of the layout. A 7 or 11 wins the *Come* bet at even money, loses the *Don’t Come* bet. A 2, 3 or 12, loses the *Come* bet. While the 2 or 3 wins the *Don’t Come* bet. Again the 12 is a push. However, should one of the point numbers be rolled (i.e., 4, 5, 6, 8, 9, or 10), that number now must be rolled before the 7 for the *Come* bettor to win. Should the 7 appear before the number, the *Don’t Come* bettor wins. The *Come-Don’t Come* is merely a game within a game. As with the *Pass* and *Don’t Pass*, the *Come* and *Don’t Come* players...
are also offered the option of Free Odds.

The last of the low-percentage bets is the placing of the 6 and/or 8, which can be done at any time. Here you simply place a wager in multiples of $6.00. The casino will pay off a winning bet at “casino odds” of $7.00 for every $6.00 wagered. The casino edge on this bet is 1.52 percent. You can place a number at any time and you can also call the bet off or take it down at any time.

Other Bets at Craps

The following bets can be placed at any time, including during the come out roll. The edges on most of these are prohibitive.

*Place the 4:* You place the 4 in multiples of five dollars. If the 4 is rolled before the 7, the player wins nine dollars. The house edge is 6.67 percent. Too much.

*Place the 5:* You place the 5 in multiples of five dollars. If the 5 rolls before a 7, the player wins seven dollars. Casino edge is four percent. Too much.

*Place the 6:* As stated, you place the 6 in multiples of six dollars. If the 6 rolls before a 7, the player wins seven dollars. Casino edge is 1.52 percent. Okay.

*Place the 8:* As stated, you place the 8 in multiples of six dollars. If the 8 rolls before a 7, the player wins seven dollars. Casino edge is 1.52 percent. Okay.

*Place the 9:* You place the 9 in multiples of five dollars. If the 9 rolls before a 7, the player wins seven dollars. Casino edge is four percent. Too much.

*Place the 10:* You place the 10 in multiples of five dollars. If the 10 is rolled before the 7, the player wins nine dollars. The house edge is 6.67 percent. Too much.
**Place to Lose**

You can also place the numbers to lose, sometimes this is called laying the numbers, as in: “Lay the 4!” In such a case, you are rooting for a 7 to be thrown before the number appears.

**Place the 4 to Lose:** Here you bet in multiples of $11 that the 7 will come up before the 4. If you win, you receive five dollars. The house edge is 3.03 percent. Too much.

**Place the 5 to Lose:** Here you bet in multiples of eight dollars that the 7 will come up before the 5. If you win, you bet is paid off at five dollars. The house edge is 2.5 percent. Marginal.

**Place the 6 to Lose:** Here you are betting in multiples of five dollars that the 7 will be rolled before the 6. If you win, the bet is paid off at four dollars. The house edge is 1.82 percent. Okay.

**Place the 8 to Lose:** Here you are betting in multiples of five dollars that the 7 will be rolled before the 8. If you win, the bet is paid off at four dollars. The house edge is 1.82 percent. Okay.

**Place the 9 to Lose:** Here you bet in multiples of eight dollars that the 7 will come up before the 9. If you win, you the bet is paid off at five dollars. The house edge is 2.5 percent. Marginal.

**Place the 10 to Lose:** Here you bet in multiples of $11 that the 7 will come up before the 10. If you win, you receive five dollars. The house edge is 3.03 percent. Too much.

**Proposition Bets**

**Hard 4:** You are betting that the 4 will be made as 2:2 before a 7 is rolled or before the 4 is rolled as 3:1 or 1:3. Pays 7 to 1. House edge is
11.11 percent. Awful.

**Hard 6:** You are betting that the 6 will be made as 3:3 before a 7 is rolled or before the 6 is made as 5:1, 1:5, 4:2 or 2:4. Pays 9 to 1. House edge is 9.09 percent. Awful.

**Hard 8:** You are betting that the 8 will be made as 4:4 before the 7 is rolled or before the 8 is rolled as 5:3, 3:5 or 6:2, 2:6. Pays 9 to 1. House edge is 9.09 percent. Awful.

**Hard 10:** You are betting that the 10 will be made as 5:5 before a 7 is rolled or before the 10 is rolled as 6:4 or 4:6. Pays 7 to 1. House edge is 11.11 percent. Awful.

**One-Roll Proposition Bets**

The bets listed are one-roll wagers and the usual payoff for them. Some casinos will pay at a higher rate. The more the casino pays, the lower the house edge.

**The Field:** A one-roll wager that the next number will be one of the Field numbers: 2, 3, 4, 9, 10, 11, 12. Sometimes the 5 is substituted for the 9. If the 2 or 12 hits, it is paid off at 2 to 1. The other numbers are paid off at 1 to 1. The house edge is 5.26 percent. Too much.

**The 2:** A one-roll wager that the next number will be a 2. Pays off at 30 to 1. The house edge is 13.89 percent. Truly awful.

**Hard 4 Hop:** A one-roll wager that the next number will be a 4 made as 2:2. Pays off at 30 to 1. The house edge is 13.89 percent. Truly awful.

**Hard 6 Hop:** A one-roll wager that the next number will be a 6 made as 3:3. Pays off at 30 to 1. The house edge is 13.89 percent. Truly awful.

**Hard 8 Hop:** A one-roll wager that the next number will be an 8 made
as 4:4. Pays off at 30 to 1. The house edge is 13.89 percent. Truly awful.

**Hard 10 Hop:** A one-roll wager that the next number will be a 10 made as 5:5. Pays off at 30 to 1. The house edge is 13.89 percent.

**The 12:** A one-roll wager that the next number will be a 12. Pays off at 30 to 1. The house edge is 13.89 percent. Truly awful.

**The 3:** A one-roll wager that the next number will be a 3. Pays off at 15 to 1. The house edge is 11.11 percent. Awful.

**The 11:** A one-roll wager that the next number will be an 11. Pays off at 15 to 1. The house edge is 11.11 percent. Awful.

**Any Craps:** A one-roll wager that the next number will be a craps: 2, 3, or 12. Pays off at 7 to 1. The house edge is 11.11 percent. Awful.

**Any 7:** A one-roll wager that the next number will be a 7. Pays off at 4 to 1. House edge is 16.67 percent. Wins the prize as the worst bet at craps!

**Horn Bet:** A one-roll wager that the next number will be either a 2, 3, 11 or 12. House pays off at the odds for the individual number as above. House edge is a combined 12.50 percent. Awful.

### The Language of Craps

Most people in America speak English. Many speak Spanish. Still others speak French or German or Italian or Hindi or Mandarin or Japanese or any one of over 100 languages and dialects that can be found in the home of the brave and the land of the free. Of course, everyone is proud of his or her language, as language and culture go hand in hand. And who doesn’t think his or her culture isn’t the greatest thing in the world? (“I’m proud to be a Gugnodo! We built the first mounds of dung before the pyramids appeared!”)
Poor fools. Poor deluded fools.

Don’t they know that while their languages are okay (after all, in most them you can call a taxi, order some food, tell the spouse to take out the garbage and invade that village over there), there is only one language that has the color, charm, fantasy, enthusiasm, and descriptive power to make it the number one language in the world or at least that part of the world that is worth discussing. Of course, I mean the casino world. And its greatest language is known as “the lingo of craps.”

As with all great languages, craps has its own dictionary (you know a language has made it when it has a whole book devoted to it!), a slim volume titled A Guide to Craps Lingo: From Snake Eyes to Muleteeth. What Webster did for the English language, Chris Fagans and David Guzman have done for craps.

Once you have read this book, you will be truly bilingual. You’ll be able to speak your inferior language and the superior language of craps.

Let me give you some linguistic enlightenment:

Of course, everyone knows what “snake eyes” means (your daughter’s boyfriend), and everyone has heard of “yo” as in Rocky’s classic comment after he suffered serious brain damage: “Yo, Adrian, I did it!” Poor Rocky, when asked what he had actually done, he couldn’t quite remember. So he said: “yo-eleven” which he thought was the round he had been knocked out in. And that’s how “yo-eleven” became a craps call. In honor of really stupid New Yorkers, the “eleven” is sometimes referred to as a Star Wars character, “Yo-Duh.”

And did you know that “Little Joe” is not just a character on the old Bonanza series but another way to say “four.” You could also say “Tutu.” No, not in honor of the South African bishop or to describe what a ballet dancer wears, but again as another way to say “four.”

Remember that old Rosemary Clooney song, “You Give Me Fever”? Well, I was five when I first heard it and guess what -- that’s what fever means in craps -- a “five.” So when you put your bet down for a “five,” just say: “I got a fever for you.” Of course, if the dealer doesn’t know what that means, he might think you’re coming on to him or he might get upset because he thinks you have some rare tropical disease, or both. Here’s a colorfully disgusting call from a stickman when the “five” rolls: “Five! It snot in the field, clean it up!”

The number “six” doesn’t have many really good synonyms but “the lumber number” certainly conjures images in the imagination best left unwritten.
The “seven” is the most dreaded number in craps after the shooter has established which point he’s shooting for. It is called the “Devil” and “Big Red.” When a shooter rolls the “seven” it can take a player to hell (“do” bettors) or to heaven (“don’t” bettors). And all craps players know, or should know, that if you say the word “seven” out loud at the table, bad luck will happen -- usually in the form of a big, superstitious guy with a wicked left hook heading for the mouth that is just finishing up saying “seveeeee” -- thump!

The “eight” has several colorful appellations. Try these the next time you place the “eight.” “Give me a square pair!” “I want two windows.” “Make that block fours.” When the shooter’s number is “eight” and he makes it, dealers can say: “He eight it!” Or, to be more genteel, a dealer might say: “Meet Ada from Decatur.”

Speaking of women, when the “nine” is your point and you make it, the dealer can shout: “Nina from Pasadena!” as Nina, plain and without the attendant city, also means “nine.” For some reason a “nine” can be referred to as a “Jesse James,” perhaps because he was shot with a 45 (which numbers, added together, equal nine). And for scurrilous stickmen, the call of “nine” goes: “9-9-9 just like mine!” (Deluded braggart!)

Evidently the British have gotten involved when it comes to the “ten,” which is labeled variously “Big Ben,” “The Ripper,” “The Queen’s Crown” and something too gross to mention in mixed company or even alone. It is also called “Sunflowers,” “Double Nickels,” “Venus and Mars” and a “Tennessee Tottie.”

Finally, you have the famous “Box Cars” or 12, which can also be called: “Midnight,” “The Apostles,” “Six-Packs,” and “Muleteeth.”

Most cultures have a religious component and some scholars would say that religion and culture go together like a horse and carriage (or was that love and marriage?). Anyway, you will find many religious and moral sayings in the culture of craps, as in this plea to the craps deities: “Come on, baby needs a new pair of shoes!” Of course, baby needs a new pair of shoes because pop is busy playing craps with the shoe money!

“Peace on earth, good will to men.” If you like that saying, the craps equivalent is much easier to understand: “Dice -- be nice!” And here’s the most dreaded of all craps calls: “The devil jumped up!” That means the nasty 7 - just ended a shooters roll.

Craps, like any culture, has many rules to follow. Here are some, which I have dubbed, the Ten Commandments of Craps:
1. Never put down a bet when the dice are in the air. If the dice hit the money or the chips, the 7 will result and that big guy I mentioned earlier will be aiming for you.

2. Never talk to a shooter who is about to roll. If you do, that 7 will come up.

3. Never push your way into a game next to a person who is shooting. If you bump him, you know what will happen and you know what big guy will be after you.

4. Never say the word “seven” at a craps table. If you do, it will appear.

5. Never think the word “seven” at a craps table. If you do, it will appear.

6. Never take new dice if a die goes off the table. Ask for “same dice” or guess what will appear?

7. Never dangle your hands over the table because if the dice hit them, the devil will jump up and so will that devilish big guy who punches people.

8. Never delay the game because a hot shooter always cools off during delays and you know what number will come up then. If you can’t figure out what bets you made, don’t make them anymore – and take your ginkgo biloba.

9. Never yell at someone who sevens-out early. If you do, when it’s your turn, you’ll seven-out early too.

10. Never tell people how much money you’ve won playing craps because they’ll actually expect you to buy baby a new pair of shoes!

### The Ten Minutes or Less Craps Strategy

1. Bet Pass Line for the minimum and back it with as much in odds as you can afford when the point is established. If you plan to bet $15, you are better off betting it as $5 on the Pass Line and $10 in odds, than betting all $15 on the Pass Line.
2. When the point is established, if it is the 6 or the 8, then bet the other in multiples of $6. Say, the point is 8. You have $5 plus $10 in odds ($15 total); then bet $12 on the 6. Since the 6 and 8 are the numbers with the second highest frequency of appearing, you have the best chance of winning on them.

3. When the point is established, if neither is a 6 or 8, then also Place the 6 and 8 in multiples of $6. You’ll have three numbers working for you, the Pass Line, and the 6 and 8. It will be easy to keep track of your bets this way.

4. If you only want to bet two numbers, simply Place the 6 and 8 in multiples of $6.

5. You should have ten times the amount of your “spread” as a session stake. Thus, if you are betting $6 on the 6 and 8, you have a “spread” of $12. You should have at least $120 to play with.

6. Ignore all the other bets at the table.

**For More Information About Craps**

There is a craps revolution going on in America, due in part to savvy craps players’ acceptance of the Captain’s contentions that some shooters have the ability to change the nature of the odds they face due to their controlled shooting or “rhythmic rolling.” I’ve written about the Captain and his theories in several books and tapes. In addition, the phenomenal analyses and teaching skill of Sharpshooter, a young engineer, and Dominator, Mr. Finesse, and Bill Burton, dice-control experts and teachers who have refined and expanded on the theory and practice of the Captain’s methods, have gone a long way towards making craps a beatable game for those in the know. Here then is a list of books, tapes and teaching seminars, which I highly recommend. Craps is a good game, even if you don’t practice a controlled rhythmic roll; but it is a great game when you do!

*The Golden Touch Dice Control Revolution* by Frank Scoblete and
Dominator (Research Services, $19.95) The most advanced book on dice control by two of the leading shooters in the world. Let Frank and Dominator show you in 70 pictures how getting an advantage at craps is possible. Covers the 8 Physical Elements of the controlled throw and the best bets to make depending on your edge. Also covers in depth how to bet on random rollers so they won’t lose you too much money. This is the book that could start you on your way to winning!

*Beat the Craps Out of the Casinos: How to Play Craps and Win!* by Frank Scoblete (Bonus Books, $12.95): The classic, best-selling craps book of all time, now updated with new chapters. Introduces the Captain and discusses his revolutionary methods of play, including the *5-Count*, the *Supersystem* and *Pushing the House*. You’ll also read about the Captain’s Crew of high rollers and the remarkable lady known as “the Arm” – the precision shooter who became a legend in Atlantic City craps circles.

*The Captain’s Craps Revolution!* by Frank Scoblete (Paone Press, $21.95): The follow-up to *Beat the Craps Out of the Casinos*, this is a no-nonsense look at the classic and radical *Supersystems*, a detailed analysis of the *5-Count* and why it works, an exploration of new bets such as the Oddsman’s bet and “buying” player don’t bets. Has the best Darkside strategy recommended by the Captain for those who play the “don’t” side of the game.

*Forever Craps: The Five-Step Advantage-Play Method* by Frank Scoblete (Bonus Books, $13.95): Five steps that will allow you to achieve a monetary edge over the casinos. This book shows you how to utilize a rhythmic roll or precision shot to flip the house edge in your favor. In addition, it explains how to utilize the *5-Count* with the Golden Shooter rule to determine which other shooters might be changing the odds – the shooters who are worth risking your money on. Full explanation on how to get more comps for less risk. Contains the complete biography of the Captain!

*Sharpshooter Craps!* by Frank Scoblete (Paone Press, Audio Cassette, 60 minutes, $16.95): This tape discusses how to use the *5-Count*, how to select a table, how to become a rhythmic roller, how manage your money and how to get the mental edge as well information about the origins and practice of craps.
Product History and Platforms

DeepNet Technologies (http://www.deepnettech.com) specializes in gambling training software products and resources for players looking to leverage the maximum edge in casino games.

Blackjack Training Software

DeepNet Technologies develops a wide range of professional Blackjack software programs for Palm OS, Pocket PC, and Windows. We are the only company that provides Basic Strategy, Card Counting, and Simulation training software for Handheld devices and Windows. We are committed to helping Blackjack players, both novices and experts, excel at the game.

Blackjack Mentor (Windows, Palm OS, Pocket PC)
- Learn blackjack basic strategy the fast and easy way with Blackjack Mentor. Packed with fun drills and tests to help you memorize the right blackjack plays, for all variations in the rules.

Blackjack Counter (Windows, Palm OS, Pocket PC)
- All the features of Blackjack Mentor, plus advanced card counting training. Powerful tests and drills to master card counting, from betting to expert play indices. Includes many count systems, and a feature-rich count system editor.

Blackjack Audit (Windows)
- Run millions of blackjack hands to virtually any game or card counting settings imaginable, and see the statistical results. Blackjack Audit is a powerful and full-featured simulator, including ROR (risk of ruin) simulation and calculators.

Blackjack Resources

Blackjack Count Master e-Book (Adobe Acrobat PDF)
- Our new book is the perfect companion for our quality software line: a step-by-step training guide that will teach you how to count cards using our software. Over 100 pages including 15 targeted exercises using our Blackjack Counter and Blackjack Expert software, designed to guide you from the very beginnings of Basic Strategy to the most advanced techniques of card counting.

Blackjack Insider Monthly e-Newsletter (www.bjinsider.com)
- The best advice and articles on blackjack and gaming. Published
monthly since 2001, the *Blackjack Insider* is the best source for great articles by leading experts and authorities on gambling. Free monthly issues delivered right to your e-mail box!


- An intense hands-on training course developed by DeepNet Technologies that will turn you into an positive advantage blackjack player in one weekend!

- Learn *Speed Count*, a **never-before-revealed method** of advantage-play that is SIMPLE, extremely EASY-TO-APPLY, yet POWERFUL enough to get a REAL, VERIFIABLE EDGE over the casinos at blackjack! Comes with a NEW Basic Strategy that enhances your edge with our method! Plus, entrance and exit strategies, money management, bankroll development and bet-sizing techniques to make you an ADVANTAGE-PLAYER over the house.
Registration and Purchasing

To purchase this program, please visit our web site: (http://www.deepnettech.com/store.html). Use our secure servers to complete your purchase online, and receive an immediate registration code!

Our products are 'registration shareware'; there is only one program to download that is both the free demo and purchased version. You may copy and distribute the shareware version as much as you like, as long as you do not modify it. While unregistered, the software will occasionally remind you to register the product, and reset the program. Purchasing the product provides you with a registration code to enter into the program and disable all shareware 'nags'.

Temporary Registration Code

When you purchase any of our software, you are immediately issued a temporary registration code that will last for two weeks. Later, DeepNet Technologies will e-mail you a unique permanent code that you should re-enter when you receive it. Simply select 'Register' from the Help menu and enter the new code.

Note: make sure you provide a valid e-mail address when you purchase our software! This is where your permanent registration code is sent.

Permanent Registration Code

Unique permanent registration codes are generated for each purchaser of our software. These codes are for your personal use and may not be shared with any one else. The permanent registration codes will only work if you enter the same e-mail address that you provided when you purchased the program.
The Theory of Dice Control

This chapter is intended as a brief summary only on dice control and the physical skill of dice setting. If you want to master the physical skill of dice setting, you will want to read and consult with some of the resources in the "Resources »Page 7" section of this documentation. Unlike card counting in blackjack, dice setting is a physical skill, and cannot be mastered through reading and mental practice alone.

Dice setters attempt to control the physical throw of the dice in such a way as to influence the outcome of the dice. This skill, when used consciously at different points in the game, generates a non-random distribution of outcomes, which the shooter hopes reverses the casino's edge in the game to the player's favor. To understand the physics of dice control, let's look at an actual craps table:

![Figure 1: Axes of rotation on a craps table](image)

With these labels, we can see that a shooter will be throwing the dice along the X axis toward the end of the table. Generally, a skilled dice setter will hold the dice together, parallel to the Z axis, as shown below:
Figure 2: Throwing the dice parallel to the Z axis of the table

A typical controlled shooter is attempting to cause the dice to rotate only around the Z axis. In theory, any spin in the Y or X axis can introduce unexpected bounces and a less controlled outcome. With a spin in only the Z axis, the outside numbers on the dice set should not occur in the final roll result.

Now that we understand the basic physics of dice control, we can see that the actual dice set is relevant for a skilled shooter. The set determines exactly what numbers are on top and on the sides for both dice. In the above figure, the twos are on top and the fours are on the front. The standard notation used in *Smart Craps* would describe this dice set as T2F4/T2F4, meaning the two on top and four in front for the left die and right die. The notation T3F5/T3F1 is often called the 3Vset in popular texts, for example. Describing the top and front of a die (actually, any two adjacent sides will do) completely determines the values of the remaining sides. The ‘T’ and ‘F’ can be dropped, shortening the notation for a set, such as the 3V, to 35/31.

As well as limiting the spin of the dice to the Z axis, extremely proficient controlled shooters also try and fix the rate of spin for both dice to be the same. This can further reduce the dice outcomes for advantage.
play. For example, with a 24/24 or hard way set (sixes and ones on the outside), a perfectly controlled throw with Z axis rotation only at the same speed for both dice means the outcome should be one of: 22, 33, 44 or 55.

Using a hard way set again, suppose a controlled shooter achieves Z axis control but not rotation rate. In theory, the possible outcomes are the sixteen permutations of the four on-axis sides: 22, 23, 24, 25, 32, 33, 34, 35, 42, 43, 44, 45, 52, 53, 54, and 55. Notice that there are passing outcomes that sum to seven, as well as failures (61, 16). This will come into play when we talk about the statistics of dice setting, and the best way to determine if a skilled shooter is influencing the outcomes.

In the next sections, we discuss two ways of determining if a shooter is in fact influencing the dice outcomes: SRR (Seven to Rolls Ratio) and the new Pro Test by DeepNet Technologies.

________________________

Next topic in this section
SRR - Seven to Rolls Ratio

Ok... you claim to be an expert dice controller, and making millions at craps. Good for you! Now, how do we prove it, with the same kind of mathematical certainty that we talk about with card counting in blackjack?

The most common statistical analysis of the game of craps to date is the SRR: seven to rolls ratio. This measures the number of seven sums in two dice compared to the other outcomes. If you are a random shooter, you will roll one seven in every six rolls (or, one seven for every five non-sevens). This simple fact can be seen if we look at all possible outcomes for the sum of two dice:

<table>
<thead>
<tr>
<th>Roll:</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>11</td>
<td>12</td>
<td>13</td>
<td>14</td>
<td>15</td>
<td>16</td>
<td>62</td>
<td>63</td>
<td>64</td>
<td>56</td>
<td>66</td>
</tr>
<tr>
<td></td>
<td>21</td>
<td>31</td>
<td>41</td>
<td>51</td>
<td>61</td>
<td>26</td>
<td>36</td>
<td>46</td>
<td>65</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>22</td>
<td>23</td>
<td>24</td>
<td>25</td>
<td>35</td>
<td>45</td>
<td>55</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>32</td>
<td>42</td>
<td>52</td>
<td>53</td>
<td>54</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>33</td>
<td>34</td>
<td>44</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>43</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Total: 1 2 3 4 5 6 5 4 3 2 1 = 36

Figure 3: Dice outcomes for a random shooter

The above table for a dice controller will be quite different, but the number we concentrate on is the number of seven outcomes. On the come out roll, we want to maximize the number of sevens (i.e. have the lowest possible SRR ratio), and on any point roll we want to minimize the number of sevens (i.e. have the highest possible SRR ratio). We should note that 'minimize' and 'maximize' may seem backwards in the above description: technically, you want to maximize the SRR fraction on a come out roll, for example, which means making the second number in the ratio proportion lower. In general, we refer to 'minimizing' the SRR to mean making the second number in the SRR ratio as low as possible, and 'maximizing' the SRR to mean making the second number in the SRR ratio as high as possible.

In Smart Craps, we model an SRR shooter by specifying both the minimum and maximum SRR ratio they are capable of achieving. Then, we can devise a betting system that uses the appropriate SRR
for different situations (the minimum SRR on come out rolls and the maximum SRR on point rolls).

With the above approach, we can convert various SRR ratios to actual player edges. In *Smart Craps*, we do this by defining a simulation matching the SRR parameters, and running it for a few million rounds. For example, if we assume the following:

- Shooter uses a controlled throw on the come out roll that minimizes their SRR to 1:5.5.
- Shooter uses a controlled throw on all point rolls that maximizes their SRR to 1:6.5.
- Zero odds game, with flat pass line bets only.
- **Player edge**: +3.43% (using 100 million craps rounds, where each round is a single bet. 342 million rolls in this case).

While it is possible to determine the player edge mathematically with different SRR values in the case of simple flat pass line bets, things get more complicated when you add unusual bets and rules (vigs, odds, uneven payouts, etc.) *Smart Craps* makes it possible to determine the true edge empirically with real-world craps scenarios and conditions, using game simulation.

It is interesting to observe that the actual dice set is not relevant when simulating SRR shooters. The SRR is a direct result of their technique and set, not the other way around. But SRR shooters are no different from any dice setter: the principles of axis rotation discussed previously apply.

Also, the actual dice sums, while very relevant to computing player edge, are not directly correlated to the influence the dice setter achieves. For example, if a shooter uses a hardway set, they may still achieve perfect z-axis rotation, not getting an outside six or one to appear, yet a seven is rolled. For example, the outcome 34 and 25 indicate perfect z-axis rotation with a hardway set. Yet, they may fail to get z-axis rotation and still get a seven with a 61 or 16 outcome. This weakens the statistical accuracy of the SRR as a good measure of dice setting skill. SRR is great for computing player edge, but is a weak statistical measure of dice setting skill.

Enter *Pro Test*... a fresh look at the statistics of dice setting, and a better mathematical approach to measuring skill and player edge.

_____________________

Next topic in this section
Pro Test: a better dice control metric

We've seen in the "SRR »Page 27" section that the seven to rolls ratio, while somewhat intuitive and useful for calculating player edge, is not the best possible measure of dice setting skill. This results from the fact that sevens can be both 'good' and 'bad', meaning that they occur when we both achieve and fail z-axis control. This weakens the statistical utility of SRR for determining player dice setting skill.

Let's take a fresh statistical look at dice control, starting with the basic physics principles described in the "Theory of Dice Control »Page 24" section.

Z-axis rotation
First and foremost, dice setters are trying to limit the dice rotation to the z-axis. This simply means that neither of the outside numbers shows up in the outcome. Hence, there are 4 times 4 = 16 possible outcomes that succeed in rotating in the Z-axis only. With a hardway set, this means each die outcome is one of: 2, 3, 4 and 5.

Secondly, a good dice setter tries to control the number of face rotations or pitches between the two dice when they do achieve z-axis control. Ideally, the two dice leave their hands in perfect symmetry, and rotate equally in the z-axis, bounce off the floor and back, and land with one of four possible outcomes. With a hardway set, this means one of: 22, 33, 44, or 55.

Thirdly, dice setters attempt to try to limit the number of double pitches when they achieve z-axis control. Ideally, the dice land up together (zero face rotations as noted above), or single pitch (are offset by 90 degrees or one rotation). Eliminating double pitches is useful with some dice sets, such as the hardway set: the only seven sums on the z-axis controlled outcomes occur when the dice double pitch (52, 25, 34 and 43). This can be relevant in different points of the game, such as point cycle rolls.

Thinking in practical terms, how do we know if a throw has stayed on z-axis rotation for any given dice set? Or, how do we know how many face rotations or pitches occurred on those successes? While it is very clear with a hardway dice set, other sets will lead to ambiguous results unless the dice are clearly marked (or colored) and the starting dice set recorded. For the purposes of the Pro Test, we always use a hardway set, to eliminate this challenge. Hence, the actual dice sums are completely irrelevant, and say nothing immediately about our edge in craps. But we will come back to this point, and show later how we can determine our edge once we have proven our dice setting skill.
A random shooter should achieve 16 z-axis controlled outcomes on average for any 36 rolls. Of these passes, four are zero pitches, and four are double pitches. For the curious, observe that three pitches is actually a single pitch in the other direction. With this knowledge we can now ask the million dollar statistical question:

"If I roll the dice a bunch of times and observe a certain number of z-axis controlled shots, what is the probability of this occurring randomly?"

This fancy looking question is really the mathematical equivalent of asking "Is there ample evidence that I am a controlled shooter?"

________________________

Next topic in this section
Pro 1 Test

First, let's call a z-axis controlled throw a Pro 1 Test pass. Hence, with a hardway dice set, a throw is a Pro 1 pass if the one and six don’t show up in the outcome, and is a Pro 1 failure otherwise. Now, we can complete a roll set of throws, and record how many times we passed and failed the Pro 1 test (each outcome is either a pass or failure).

Now, if we really are capable of influencing the dice outcomes, then we should be able to record a bunch of throws, and the number of Pro 1 passes should be high enough to provide ample evidence of our skill. But how many passes in how many rolls is enough?

To answer these kinds of questions, mathematicians turn to statistical confidence measures. A mathematician will ask:

"What is the probability of a random shooter achieving that many Pro 1 passes (or more) in some number of throws?"

For our purposes, we'll say that if this percentage is less than or equal to 1%, then there is convincing evidence that our shooter is indeed influencing the dice. This means that only 1 in 100 random shooters would achieve that number of Pro 1 passes (or more).

This all sounds very convincing, but how do we convert a number of rolls and number of Pro 1 passes into a mathematically accurate confidence percentage or score? For this, we turn to a tried and true statistical method, called the Bernoulli trial.

Bernoulli trials

Consider a statistical test (independent of craps) as follows:

- You can perform a test (event), which has either a pass or fail outcome. The fail outcome has probability \( p \), and the pass outcome has probability \( 1 - p \).

- You repeat this test \( n \) times, observing \( k \) failed outcomes, and \( n - k \) passes.

- Question: What is the probability of \( k \) (or less) failures?

This kind of statistical test is called a Bernoulli trial, and is common fare in any first-year university statistics book or course. Here is the equation for the probability of failing \( k \) (or less) events (with probability \( p \) of failure each) in \( n \) trials:

\[
P_k^n = \sum_{i=0}^{k} \binom{n}{i} p^i (1 - p)^{(n-i)}
\]
Figure 4: Bernoulli equation

The Bernoulli formula looks simple, but is not the kind of thing that can be computed by hand easily for any sizable ‘n’ (such as 100 or 500). But it is an easy matter to code this formula on a computer, which is exactly what is done in Smart Craps. When the program displays a Pro Test score, it is simply using the formula above to compute the statistical probability of the observed number of Pro Test passes (or equivalently, failures). When it displays the minimum number of passes required to pass a Pro Test in some number of rolls, it is simply running the Bernoulli equation a bunch of times to determine the number of passes that yields no more than 1% probability.

How does this relate to craps? Suppose a controlled shooter makes $n$ throws with a hardway set, and we see $k$ Pro 1 failures (i.e. $n - k$ Pro 1 passes). Now, we can ask what the probability is of this occurring randomly using truly random dice. If this probability is sufficiently low, then there is a much greater likelihood that the shooter is instead successfully controlling the dice throws than the result being coincidence.

First, we need to determine $p$, the probability of a six or one (or both) showing up when using a hardway set (i.e. sixes and ones on the outside). The probability of a six or one not showing up on two independent and random dice rolls is $\frac{4}{6} \times \frac{4}{6} = \frac{2}{3} \times \frac{2}{3} = \frac{4}{9}$. Therefore, the probability of seeing a six or one show up on either (or both) dice is $1 - \frac{4}{9} = \frac{5}{9}$. Hence, $p$ equals 0.5555556 for our craps statistical test.

With this knowledge, we can solve the Bernoulli equation for any particular shooters’ Pro 1 test score (probability).

Bernoulli equation from first principles

The Bernoulli equation is very easy to determine from scratch. For those with a mathematical bent, here is the proof (and for those without, please feel free to skip this section):

- Suppose we ask what the probability is of exactly $k$ failures in $n$ trials with probability of failure $p$.

\[
\binom{n}{k} p^k (1 - p)^{n-k}
\]

- There are $\binom{n}{k}$ (n choose k) possible permutations where we can have exactly $k$ failures, and $n - k$ passes.

- The probability for any one of these events is

\[
p^k (1 - p)^{n-k}
\]
• We can sum the probability of all these events to get the total probability of any exact \( k \) failures combination:

\[
E_k^n = \binom{n}{k} p^k (1 - p)^{n-k}
\]

• Hence, the probability of \( k \) or less failures in \( n \) trials with probability \( p \) of failure is simply the sum of the above equations from zero to \( k \) (inclusive):

\[
P_k^n = \sum_{i=0}^{k} \binom{n}{i} p^i (1 - p)^{n-i}
\]

It should be noted that even on a computer, the Bernoulli equation is problematic for \( n \) (number of rolls) over 1000. In these cases, the first combinatorial term can quickly overflow the available precision for standard computer math libraries.

To solve this case, \textit{Smart Craps} uses a standard normal approximation for the probability function when more than 1000 rolls are specified. While not as accurate as the above method, it is always within one roll of the actual exact result (with the Bernoulli equation). Given a desired probability (99%, or 1% by chance), we can solve for the minimum number of Pro Test passes:

\[
MP = n \times p + \text{N}(0.99) \times \sqrt{p \times (1-p)} / n \times n
\]

\( MP = \) Minimum number of passes required
\( \text{N}(0.99) = \) Normal cumulative distribution function for 99% (\( \text{N}(0.99) = 2.326 \))

Next topic in this section
**Pro 2 Test**

The second *degree of freedom* (or DOF) dice setters attempt to control is the number of face rotations or pitches on their Pro 1 passes (Pro 1 passes, or z-axis control, is the first degree of freedom). Let's call any Pro 1 Test pass that lands with both the dice in sync a *Pro 2 Test pass*. For example with the hardway set, the results 22, 33, 44 and 55 are Pro 2 passes, while all other results are Pro 2 failures. Notice that all Pro 2 passes are, by default, Pro 1 passes.

Now, we can ask the same question as before:

"What is the probability of a random shooter achieving some number of Pro 2 passes (or more) in some number of throws?"

On the surface, it would seem that we just use the Bernoulli equation again, using $[1 - 4/36] = 8/9$ for $p$, with $k$ Pro 2 failures in $n$ rolls. There are 4 Pro 2 passes in 36 throws, which means 8/9 probability of a Pro 2 failure.

But statistical tests must be based on a solid knowledge of what they are testing, and how the variables relate. In this case, the hidden wrinkle is that all Pro 2 passes are also Pro 1 passes. Given the physics of dice control, this means all Pro 2 passes are dependent on the Pro 1 passes, which has great meaning in statistical terms. Statistically analyzing the Pro 2 passes without considering the Pro 1 passes, while possible, would lead to questionable results.

To see this, suppose a shooter manages to get 80 Pro 1 passes in 100 rolls, and 20 Pro 2 passes. 20 Pro 2 passes is much more than the statistical average of $4/36 \times 100 = 11$ in 100 rolls. But, we should also see $4/16=1/4$ of our Pro 1 passes be our Pro 2 passes. So, 20 Pro 2 passes in 80 Pro 1 passes is actually statistically average. While showing good z-axis rotation control, the shooter is not managing to get zero pitches more often than expected. Analyzing Pro 2 passes compared to the number of rolls is misleading.

As such, the right statistical question to ask is:

"What is the probability of a random shooter achieving some number of Pro 2 passes (or more) in some number of Pro 1 passes?"

From this point of view, $p$ is the expected number of Pro 2 failures ($k$) in $n$ Pro 1 passes. There are 16 expected Pro 1 passes, and 4 Pro 2 passes. This means the probability of a Pro 2 failure ($p$) is $1 - 4/16 = 3/4 (75\%)$. Using the Bernoulli equation, we can then come up with the Pro 2 score or probability.
Next topic in this section
Pro 3 Test

The third degree of freedom dice setters try to minimize is the number of double pitches. A double pitch occurs on a Pro 1 pass where the two dice are rotated by two faces in the outcome. Let’s call a double pitch a Pro 3 Test failure. Unlike Pro 1 and Pro 2, we measure failures, rather than passes, with the Pro 3 Test. Hence, dice setters want to maximize their Pro 1 and 2 results, while minimizing their Pro 3 failures. Like Pro 2, all Pro 3 failures are by default Pro 1 passes. The hardway dice set, for example, has these four Pro 3 failures: 25, 52, 34, 43.

In the same way as we did with Pro 2, we can assess the statistical probability of some observed number of Pro 3 failures, using the Bernoulli equation. There are 16 expected Pro 1 passes, and 4 Pro 3 failures. This means the ‘p’ is 4/16 = 1/4, ‘k’ is the number of Pro 3 failures, and ‘n’ is the number of Pro 1 passes.

Next topic in this section
Pro Test In Practice

So how many test rolls do we need to pass the three Pro Tests? Using the Pro test Solver in *Smart Craps*, we can easily determine the requirements:

<table>
<thead>
<tr>
<th># rolls (n)</th>
<th>Expected # of Pro 1 passes for a random shooter</th>
<th>Minimum # of Pro 1 passes for a 1% probability (n - k)</th>
<th>Pro 1 probability</th>
<th># of Pro 1 passes as % of # of rolls</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>44 (4/9 of 100)</td>
<td>57</td>
<td>0.78%</td>
<td>57%</td>
</tr>
<tr>
<td>200</td>
<td>88</td>
<td>106</td>
<td>0.92%</td>
<td>53%</td>
</tr>
<tr>
<td>300</td>
<td>133</td>
<td>154</td>
<td>0.97%</td>
<td>51.33%</td>
</tr>
<tr>
<td>400</td>
<td>177</td>
<td>202</td>
<td>0.86%</td>
<td>50.50%</td>
</tr>
<tr>
<td>500</td>
<td>222</td>
<td>249</td>
<td>0.92%</td>
<td>49.80%</td>
</tr>
<tr>
<td>600</td>
<td>266</td>
<td>296</td>
<td>0.91%</td>
<td>49.33%</td>
</tr>
<tr>
<td>700</td>
<td>311</td>
<td>343</td>
<td>0.86%</td>
<td>49.00%</td>
</tr>
<tr>
<td>800</td>
<td>355</td>
<td>389</td>
<td>0.97%</td>
<td>48.63%</td>
</tr>
<tr>
<td>900</td>
<td>400</td>
<td>436</td>
<td>0.87%</td>
<td>48.44%</td>
</tr>
<tr>
<td>1000</td>
<td>444</td>
<td>482</td>
<td>0.93%</td>
<td>48.20%</td>
</tr>
</tbody>
</table>

**Figure 5: Pro 1 Test requirements**

We are assuming the same 1% pass requirements in the table above as before. In 100 rolls, we only need 13 'extra' Pro 1 passes to yield a 1% pass, 18 in 200, and 21 in 300, etc. From the ratio column, we can see that the challenge of passing the Pro 1 Test gets easier as we add additional rolls. This is not surprising, since the statistical meaning of the results improves as we add more 'events' or rolls. The ratio of Pro 1 passes to number of rolls will approach the expected average of 44.44% (4/9) as the number of rolls increases. It is also equally true that a more skilled dice setter will be able to pass the Pro Test in less rolls than a modest performing shooter.

In tests with actual practicing dice setters, skilled shooters are capable of passing the Pro 1 Test in 100 to 500 rolls, in controlled test conditions. Measuring actual throws in a live casino is not advised, since the shooter most likely will employ dice sets that make recording Pro Test passes difficult. In all Pro Tests, the shooter must use the hardway set, and should record the actual throw as well as the Pro Test pass/failures.
Let's look at the Pro 2 pass requirements:

<table>
<thead>
<tr>
<th># of Pro 1 passes</th>
<th>Expected # of Pro 2 passes for a random shooter</th>
<th>Minimum # of Pro 2 passes for a 1% probability (n - k)</th>
<th>Pro 2 probability</th>
<th># of Pro 2 passes as % of Pro 1 passes</th>
</tr>
</thead>
<tbody>
<tr>
<td>57</td>
<td>14 (1/4 of 57)</td>
<td>23</td>
<td>0.77%</td>
<td>40.35%</td>
</tr>
<tr>
<td>106</td>
<td>26</td>
<td>38</td>
<td>0.84%</td>
<td>35.84%</td>
</tr>
<tr>
<td>154</td>
<td>38</td>
<td>52</td>
<td>0.92%</td>
<td>33.77%</td>
</tr>
<tr>
<td>202</td>
<td>50</td>
<td>66</td>
<td>0.87%</td>
<td>32.67%</td>
</tr>
<tr>
<td>249</td>
<td>62</td>
<td>79</td>
<td>0.99%</td>
<td>31.73%</td>
</tr>
<tr>
<td>296</td>
<td>74</td>
<td>93</td>
<td>0.75%</td>
<td>31.42%</td>
</tr>
<tr>
<td>343</td>
<td>85</td>
<td>106</td>
<td>0.78%</td>
<td>29.15%</td>
</tr>
<tr>
<td>389</td>
<td>97</td>
<td>118</td>
<td>0.99%</td>
<td>30.33%</td>
</tr>
<tr>
<td>436</td>
<td>109</td>
<td>131</td>
<td>0.97%</td>
<td>30.05%</td>
</tr>
<tr>
<td>482</td>
<td>120</td>
<td>144</td>
<td>0.86%</td>
<td>29.88%</td>
</tr>
</tbody>
</table>

**Figure 6: Pro 2 Test requirements**

We used the minimum Pro 1 pass values as the basis above. Similar to the Pro 1 results, notice that the ratio of Pro 2 passes to Pro 1 passes decreases with increasing sample size, making the Pro 2 Test easier to pass as you add more rolls. The ratio of Pro 2 passes to Pro 1 passes will approach the expected average of 25% (1/4) as the number of rolls (and hence, Pro 1 passes) increases.

What happens if a shooter can pass one Pro Test, but not the others? This is completely acceptable with Pro Test, and *Smart Craps* allows you to test this. Let's look at different Pro 2 Test results in exactly 200 rolls:

<table>
<thead>
<tr>
<th># of Pro 1 passes</th>
<th>Pro 1 probability/pass?</th>
<th>Minimum # of Pro 2 passes for a 1% probability (n - k)</th>
<th>Pro 2 probability</th>
</tr>
</thead>
<tbody>
<tr>
<td>88</td>
<td>57.73%/no</td>
<td>33</td>
<td>0.63%</td>
</tr>
<tr>
<td>90</td>
<td>46.43%/no</td>
<td>33</td>
<td>0.93%</td>
</tr>
<tr>
<td>92</td>
<td>35.43%/no</td>
<td>34</td>
<td>0.73%</td>
</tr>
<tr>
<td>94</td>
<td>25.54%/no</td>
<td>35</td>
<td>0.57%</td>
</tr>
<tr>
<td>96</td>
<td>17.33%/no</td>
<td>35</td>
<td>0.83%</td>
</tr>
<tr>
<td># of Pro 1 passes</td>
<td>Expected # of Pro 3 failures for a random shooter</td>
<td>Maximum # of Pro 3 failures for a 1% probability (n - k)</td>
<td>Pro 3 probability</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------</td>
<td>------------------------------------------------.</td>
<td>------------------</td>
</tr>
<tr>
<td>57</td>
<td>15 (1/4 of 57)</td>
<td>6</td>
<td>0.55%</td>
</tr>
<tr>
<td>106</td>
<td>27</td>
<td>16</td>
<td>0.97%</td>
</tr>
<tr>
<td>154</td>
<td>39</td>
<td>25</td>
<td>0.60%</td>
</tr>
<tr>
<td>202</td>
<td>51</td>
<td>36</td>
<td>0.96%</td>
</tr>
<tr>
<td>249</td>
<td>63</td>
<td>46</td>
<td>0.90%</td>
</tr>
<tr>
<td>296</td>
<td>74</td>
<td>56</td>
<td>0.80%</td>
</tr>
<tr>
<td>343</td>
<td>86</td>
<td>66</td>
<td>0.70%</td>
</tr>
<tr>
<td>389</td>
<td>98</td>
<td>77</td>
<td>0.91%</td>
</tr>
<tr>
<td>436</td>
<td>109</td>
<td>87</td>
<td>0.76%</td>
</tr>
<tr>
<td>482</td>
<td>121</td>
<td>98</td>
<td>0.92%</td>
</tr>
</tbody>
</table>

**Figure 7: Pro 2 passing requirements with Pro 1 failing results**

Since the Pro 2 pass criterion is dependent on the Pro 1 passes, we need far less Pro 2 passes with low Pro 1 pass results. This may indicate a shooter who is not yet controlling z-axis rotation all that well, but when they do, they manage to keep the dice spinning together very well. In *Smart Craps*, you can enable and disable any combination of the three Pro tests.

Lastly, let's look at the Pro 3 pass requirements:

As with the Pro 2 results, notice that the ratio of Pro 3 passes to Pro 1 passes increases with increasing sample size, making the Pro 3 Test easier to pass as you add more rolls. The ratio of Pro 3 passes to Pro 1 passes will approach the expected average of 25% (1/4) as the number of rolls (and hence, Pro 1 passes) increases.
What if I fail the Pro Test?

On the surface, mastering dice control seems easy… just roll the dice a few hundred times, and all you have to do is get about 1/2 of them or more as Pro 1 passes! What can be easier? Well, about 99 out of 100 things...

Remember that the passing metrics for all the Pro Tests is that there is 1% chance or less that a random shooter could replicate the result. This means it is really tough to pass! While looking deceptively easy on the surface, the reality, despite the attractive low pass numbers, is that it is very hard. It takes an incredible amount of practice and time to master the physical skill of dice setting, and even more effort to transfer that skill onto the casino floor and play with an advantage. Learning this skill cannot be done simply by reading books, like blackjack card counting: it takes actual practice throwing the dice, and lots of it! Our "Resources" »Page 7 section has lots of great courses and training literature to help you get started in mastering this skill.

So what if you fail the Pro Test? Does this mean you are not influencing the dice?

In a word… NO. Failing Pro Test does not mean you can infer the opposite result, that you are not a skilled dice controller.

Pro Test is a one-way test: it only provides statistical certainty that you are influencing dice outcomes. Due to the very high 1% confidence interval requirement for passing, failing, on its own, says very little about your lack of skill. Let's look at some examples.

Suppose you manage to roll 30 Pro 1 passes in 50 rolls. The expected number of passes was 22, so it sure looks like you are throwing in the right direction! But the actual Pro 1 Test score is 1.95%, so you failed the Pro 1 Test (you need 1% or less). But this does not mean that you should hang up your dice and find a new game! 2% as a Pro 1 score is very good, especially in 50 rolls (remember… the ratio of passes to rolls gets easier as you add more throws). Maintaining the same approximate pass ratio in more rolls is usually enough to manage a pass.

Suppose you throw an additional 50 rolls, and get 28 passes. This, by itself, is also a Pro 1 Test failure. But if we combine the results, we get 58 Pro 1 passes in 100 rolls. This is a passing Pro 1 Test result, with a score of 0.4418%… a very healthy pass! There is clear evidence that you are influencing the dice outcomes, in only 100 rolls.

Now, let's look at another example. Suppose you roll 100 rolls, and get 50 passes. The expected number for a random shooter is 44, and the Pro 1 Test score is 15.45%, clearly not a pass. But if we managed to continue with a 50% pass ratio, how many rolls would we need to pass
the Pro 1 Test? If we get 250 Pro 1 passes in 500 rolls, the Pro 1 score is 0.7168%, a healthy pass (in fact we pass with 249 or more Pro 1 passes). So, there is good reason to continue and add more throws to the test, to see if you can pass.

But what if you fail miserably, say, 45 passes in 100 throws (a Pro 1 score of 49.4%, which basically indicates a random roll set)? Well, there are no indicators that adding more rolls will help you pass. But what if you simply weren't shooting very well during that test, and your physical skill was not working at its best? Dice control is a tricky talent much like any other skill requiring practice and effort. Dice setters often refer to being 'on' or 'in a rhythm', which is not necessarily voodoo and black magic. You may get good rolls one day, and not the next.

So, suppose the next day the same shooter above tries another 100 rolls, and does get 59 passes. Alone, this is a fantastic Pro 1 pass (0.2408%). Does this mean the shooter is clearly influencing the dice, and ready to make a fortune from the casino?

There is great temptation to exclude recorded roll sets arbitrarily. But if you did so, what would prevent a truly random roller from recording 100 or more 100 throw sessions, until they eventually pass (there is a 1 in 100 chance of a random shooter passing any of the Pro Tests)? For this reason, it is very important to aggregate your recorded Pro Test results, if you want meaningful measures of your skill. In the above case, the shooter actually had 104 Pro 1 passes in 200 rolls, which is a Pro 1 score of 1.9069%. As with our first example, this is supporting evidence that the shooter is influencing the dice, but more rolls are necessary. They should practice some more, and roll an additional 100 rolls the next day when they are feeling 'strong'. Suppose they get 52 passes in the next 100 rolls, yielding 156 passes in 300 rolls. This is a Pro 1 score 0.5122%, a clear pass! As with most advantage gambling strategies, diligence, self-control and practice will help you become a better player.

What if I passed some of the Pro Tests, and fail others?

Even extremely proficient dice controllers will find that it is very difficult to pass all three Pro Tests. From actual experimental results, those who pass tend to only pass Pro 1, or pass Pro 1 and only one of the other two. Also, Pro 2 tends to be the hardest test to pass, especially if you pass Pro 1, since you need all the more Pro2 passes (and less Pro 3 failures). For modestly skilled shooters, passing Pro 3 in isolation is the most likely case. Passing even one of the Pro Tests can often be sufficient to get a positive edge on some bets.

Recording your roll sets

You've read the books about dice setting, practiced your throws,
maybe taken a course, and now you're ready to see if you're just a chicken feeder (a random shooter), or hot dice controller. Pro Test is clearly the way to answer the question, but how do you go about doing it? Follow these general guidelines for taking the Pro Test:

- **Learn the technique and skill:** there is no point taking the Pro Test unless you have learned the fundamentals, and practiced. Dice setting is not a skill you can simply experiment with for a few minutes and take a stab at. Passing a Pro test in those conditions is a reflection of luck, and nothing else!

- **Practice until it feels right:** Do sports stars just hop on the court without warming up? Of course not… and it is no difference for dice setters. From a statistical point of view, it is perfectly acceptable to practice throwing until you feel comfortable and ready to take the test. If you just don't feel 'on', then wait until the next day.

- **Get a good test environment:** You might think that the best possible conditions for the Pro Test would be a live casino, with all the distractions and challenges of a normal craps table. This is not only impractical, but also incorrect. First off, the Pro Test requires a hardway dice set, so that we can easily determine the Z-axis rotations from the throw result. This is impossible with any different set, such as the 3V, and dice setters will (and should, to maximize their advantage), use different dice sets at different times in a real game. Secondly, the purposes of Pro Test is only to see if a shooter can influence the dice (converting the measured influence to an actual dice edge is covered later). Given the very high 1% confidence interval of Pro Test, it is far better to use ideal experimental conditions. Use of a throwing station in a quiet room is acceptable, as long as you are hitting the back wall most of the time (as one does in a real casino), and the station is similar to a live casino. Furthermore, your test environment (or station) may be worse than an actual craps tables, due to factors such as a bouncy floor on non-level height. So, make sure you give yourself the best possible conditions to throw the dice. Once you pass the Pro Test, *Smart Craps* uses, by default, a reducing factor (95% confidence interval) on your actual passing ratios to replicate the added challenge of a live casino.

- **Get ready to record your throws:** *Smart Craps* includes different recording sheets (Excel, and HTML web browser files) for you to use to record your throws. Stopping after every throw to record the result can be cumbersome and interfere with your ability to pass, so you might want to get a friend to record the throws. Either way, make sure you have an easy way to record your throws accurately. See the section How to Record a Pro Test Roll Set »Page 130 for more information.
• **Start the test, and record every throw:** Decide in advance how many throws you are going to record. You will be biasing the results if you instead simply start recording throws, and stop once you suspect your skill is fading. Choose a low number of rolls, such as 50 or 100, which will not tire you out. Once you start recording rolls, **do not exclude any rolls**! Doing so would only bias the results, potentially giving you false confidence from the scores.

• **Aggregate your prior roll sets:** While it may prove helpful to analyze the roll set data alone to determine 'local' trends, you should always sum together your prior recorded roll sets when looking for complete validation of your skill. Long run, you will get generally better Pro Test passing scores as you add more rolls, assuming you are influencing the dice (remember: the Pro Test gets easier to pass as you add more rolls. This is the nature of statistical certainty tests). There are times though when you can safely start excluding roll sets (from a statistical point of view), especially over the long run. For example, your dice setting skill may improve over time, in which case including old roll sets can exert overly negative influence on your scores. Removing all roll sets older than a certain time would be acceptable. Excluding a hodge-podge of roll sets you just didn't like would be unacceptable, and bias the scores.

For specific details on recording a Pro Test roll set, make sure you also read the section See the section How to Record Pro Test Roll Set »Page 130.

**Summary**

Pro Test provides a statistically valid and solid foundation for determining whether a shooter who claims to have dice control skill is in fact influencing the outcomes. The Pro Tests have a 100% correlation to the common physical understanding of dice control (they maximize the information content of dice control, in mathematical terms). By modeling the statistical occurrences of Z-axis rotations, Pro Test is the most accurate possible measure of dice setting and influence. Within a few hundred rolls, good dice setters can state with statistical certainty that they are controlling the dice.

But what about player edge? Unlike SRR, Pro Test provides no direct guidance about the edge such proven dice influence yields. In the next section, we'll see that mathematical modeling of player edge is possible with Pro Test, once again with the help of computer code implemented in Smart Craps.

For specific details on the Pro Test settings in Smart Craps, see the section Pro Test Throw Style »Page 84.
Next topic in this section
Pro Test Player Edge

So you've practiced your dice control, recorded a few hundred throws, and pass some (or all) of the Pro Tests. Does this mean you're going to make a killing at the casino? What is your player edge (or expectation) on different bets?

While not immediately obvious, it is possible to convert Pro Test results into game expectations. To do so, you need to know:

- The rules of the craps game you are playing in, such as the odds and pay schedule.
- The specific bets you are going to make.
- The dice sets you will use at each point in the throwing cycle.
- Your Pro Test results.

*Smart Craps* has two ways for you to determine your edge in the game:

1) **Exact mathematical analysis** for given simple bets (such as pass, or don't pass, with or without odds).

2) **Craps game simulation.**

*Converting Pro Test results to exact player expectation*

Normally for a random shooter, each of the 36 dice outcomes has exactly 1 in 36 chance of occurring. For dice setters, the odds will vary for each potential outcome in a predictable manner. Once we have a combination of Pro Test results (a shooter may only pass one or two tests, or possibly all three), these can be converted into specific probabilities for each of the 36 outcomes. Once we have this and the dice sets used at every point in the game, we can determine the probabilities for each dice sum. And with this knowledge, we can determine the actual player edge given a specific betting pattern and game.

Suppose a shooter passes all three Pro Tests with results $p_1$, $p_2$ and $p_3$ in $n$ rolls (this analysis can be applied similarly if a shooter passes any combination of Pro Tests). For the moment, ignore what the actual dice set is, and think of the outcomes as being in one of the following groups:

1) **Pro 1 failures**: for any dice set, we know there are $4 \times 4 = 16$ Pro 1 passing outcomes. Therefore, there are $36 - 16 = 20$ possible Pro 1 failure outcomes.

2) **Pro 1 passes, excluding Pro 2 and 3**: We know there are 16 Pro 1 passes, and 4 each of the Pro 2 passes and Pro 3 failures. This leaves $16 - 8 = 8$ Pro 1 passes that are not Pro 2 passes and Pro 3 failures.
These are the single pitches (Pro 2 and 3 are zero and double pitches respectively).

3) Pro 2 passes: There are exactly 4 Pro 2 passes.

4) Pro 3 failures: There are exactly 4 Pro 3 failures.

For each group above, the outcomes in that group each have the same probability of occurring. For a random throw, this would be exactly 1 in 36. But for a controlled shooter, it will vary.

If a shooter passes the Pro 1 test with a value of \( p_1 \) in \( n \) rolls (such as 57 in 100 throws, in the prior example), then we can assume that the probability of all of the outcomes in the first group is 1 - \( p_1/n \). Later, we'll look more closely at this assertion, and add a further conservative confidence interval that weakens the Pro test values, even with a passing result. But for simplicity, we can guess that the shooter's actual talent leads to a probability of Pro 1 failure as noted above. For a random shooter, \( p_1/n \) is 16/36, so 1 - \( p_1/n \) = 1 - 16/36 = 5/9 = 55.56%.

For a controlled shooter (say, 57 Pro 1 Passes in 100 rolls), the probability of Pro 1 failure is: 1 - (57/100) = 43/100 = 43.00%. This is significantly less than the random shooter, not surprisingly.

If a shooter passes the Pro 2 test with a value of \( p_2 \) in \( p_1 \) Pro 1 passes (such as 23 in 57 Pro 1 passes, as we saw earlier), then the probability of the outcomes in the third group is: \( (p_2/p_1) \times (p_1/n) = p_2/n \). For a random shooter, \( p_2/n \) is 4/36 = 1/9 = 11.11%.

For a controlled shooter (say, 23 Pro 2 passes in 57 Pro 1 passes), the probability of all Pro 2 passes is 23/100 = 23.00%. This is significantly higher than the random shooter.

If a shooter passes the Pro 3 test with a value of \( p_3 \) in \( p_1 \) Pro 3 failures (such as 6 in 57 Pro 1 passes, as we saw earlier), then the probability of the outcomes in the forth group is: \( (p_3/p_1) \times (p_1/n) = p_3/n \). For a random shooter, \( p_3/n \) is 4/36 = 1/9 = 11.11%.

For a controlled shooter (say, 6 Pro 3 failures in 57 Pro 1 passes), the probability of all Pro 3 failures is 6/100 = 6.00%. This is significantly lower than the random shooter.

Now, armed with this approach and a given dice set, we can exactly state the probability of each of the 36 outcomes for a controlled shooter. Then, we can simply sum the probabilities for each unique dice sum (2 to 12), telling us the probability of each roll in craps, for the specified dice set.

If we look at a specific bet, such as a pass line bet, and specify the dice set for each situation (come out roll, 4/10 points, 5/9 points, 6/8 points), we can now come up with an actual player edge. For example, on the
come out roll, we know that a 7 or 11 will pay 1 to 1, and 2, 3 and 12 will lose our bet. Each of these four sums will have an exact probability given a dice set and specified Pro test results, as shown above.

Following this approach, it is possible to write a precise equation for the player edge, in terms of the probabilities for each dice sum given a set of specified dice sets. The mathematics is extremely complex and presented separately after this section, but thankfully you don’t need to know it… *Smart Craps* has a built-in edge calculator (in the Dice Set Optimizer »Page 96) that can turn any Pro Test scores into an exact edge percentage. This is not done via simulation, and is instantaneous! The calculator also accounts for odds (if any), and even allows you to determine the edge for proposition bets such as placing the 6 or 8.

So far the edge calculator sounds pretty good, as long as you know the dice sets that you use for each situation in the game (such as come out roll, and points). But the analysis method above could help us determine the **optimal dice sets** for any given bet. For each set of Pro Test scores and bet, there will be one (or more) optimal dice sets for the situations that yield the highest possible player edge. Each die can be oriented in one of 24 ways (6 ‘tops’ with four front facings spun around). Hence, there are 24 * 24 = 576 possible dice sets. Many of these are, of course, reflections and rotations of each other, but this does not change the following algorithm for determining the optimal dice sets:

- For each ‘situation’ (come out roll, 4/10 point, 5/9 point, 6/8 point), do the following:
  - Test all 576 dice sets, and see which one contributes the greatest player edge (or least loss). This can be done using the same analysis approach as above, considering only the win and loss outcomes for the situation. For example, on the come out roll, the edge contribution is $p_7$ (probability of a 7 sum) + $p_{11}$ - $p_2$ - $p_3$ - $p_{12}$. The remaining outcomes are points, and a similar (but more complicated) equation describes their contribution.
  - Of the 576 dice sets, one or more will be optimal, providing the greatest contribution.
  - Take the best dice sets for each situation, and re-compute the actual player edge (given the Pro Test analysis approach noted previously).

Once again, we can see that computing optimal dice sets by hand is not possible. But a computer can do it trivially, which is what the Dice Set Optimizer »Page 96 does in *Smart Craps*. It runs through these calculations for you, telling you instantly the optimal dice sets given
your Pro Test values and bets.

**Craps simulation**
The edge calculator and Dice Set Optimizer are great for simple bets and games, but the real world of craps is filled with twists and variation. What about unusual bets, such as vig or don't bets? What if you bet occasionally on random shooters? What if you vary the size of your bets according to a 'system'? While the edge calculators in *Smart Craps* are great starting tools, modeling more complex and realistic game situations quickly gets beyond the mathematical approaches described so far.

This is where the *craps simulator* comes in. In *Smart Craps*, you can completely describe every aspect of the game, including shooters, frequency of play, game rules, pay schedule, betting systems, SRR shooters, random shooters, Pro test shooters, etc. Then, run a few million (or more) rounds of craps, and see what the empirical results say. Each simulation ends in an exhaustive report file that contains virtually every possible statistic imaginable, including player edge of course.

**Summary**
Pro Test, the Dice Set Optimizer »Page 96, and the simulator in *Smart Craps*, are the essential missing links that dice controllers need to answer the universal gambling question: *How much money can I make?*

**Mathematical Derivation of Edge for Pro Test**
This section provides a mathematical derivation and proof for how the edge calculator works in Smart Craps. The sections above explained that the optimizer determines the best dice sets by cycling through all possible dice sets for each situation (come out rolls, and the four point rolls), and picking the ones that yield the highest mathematical edge. This is done by setting individual return values to each sum for the situation. For example, with the come out roll and pass bets, we set 7 and 11 to 1, and 2, 3 and 12 to -1.

But how do we calculate the actual edge, once we know the optimal dice sets for each situation?

**Pass line bet derivation**
Here is the complete mathematical derivation for the player edge with a pass line bet with odds.

\[ P_{s}^{n} : \text{Probability of the dice sum outcome } n \text{ on the situation } s \]
come out, 410 for 4 and 10 point dice sets, 68 for 6 and 8 points, and 59 for 5 and 9 points). For example, \( P^c_7 \) is the probability of a 7 on the come out roll.

\[
\text{Pay}^s_s : \text{The payout factor for an odds bet of } s. \text{ For example, } \\
\text{Pay}^{68}_{68} = 6/5 \\
\text{(odds on 6 and 8 points is 6 to 5).}
\]

**Odds**: The numeric odds provided (i.e. 5 for 5 times odds).

**Earn**: Earnings per round, assuming one dollar unit bet size.

**Exp**: The total edge or expectation for a pass line bet. Total earnings divided by total of all wagers.

\[
P^c_{pt} = P^c_4 + P^c_5 + P^c_6 + P^c_8 + P^c_9 + P^c_{10} : \text{The probability of rolling a point number on the come out roll.}
\]

\[
\therefore \text{Earn} = \left[ P^c_7 + P^c_{11} - P^c_2 - P^c_3 - P^c_{12} + P^c_{pt} \times \right. \\
\left. \left( \text{ExpPt}^{410}_4 + \text{ExpPt}^{410}_{10} + \text{ExpPt}^{59}_5 + \right) \right] \\
\text{ExpPt}^{59}_9 + \text{ExpPt}^{68}_6 + \text{ExpPt}^{68}_8
\]

Where, \[
\text{ExpPt}^s_n = \frac{P^c_n}{P^c_{pt}} \\
\left[ P^s_n - P^s_7 + 1\text{\,Odds} \times \left( \text{Pay}^s \times P^s_n - P^s_7 \right) \right] \\
P^s_n + P^s_7
\]

\[
\therefore \text{Exp} = \frac{\text{Earn}}{1 + P^c_{pt} \times \text{Odds}}
\]

*Don't pass bet derivation*
• Variables as above where referenced.

• Pushed bets (12 on come out roll) excluded from the expectation value.

• Large odds wagers are assumed in the math below (i.e. odds bet > wager, such that potential payout on the odds bet is exactly the wager). This is usually what casinos allow.

\[
\begin{align*}
\therefore \text{Earn} &= P_2^c + P_3^c - P_7^c - P_{11}^c + 0 \times P_{12}^c + P_{pt}^c \\
&\times \left[ \text{ExpPt}^{410} + \text{ExpPt}^{410} + \text{ExpPt}^{59} + \text{ExpPt}^{69} + \text{ExpPt}^{68} + \text{ExpPt}^{68} \right] \\
\text{Where, } \text{ExpPt}_n^s &= \frac{P_n^c}{P_{pt}^c} \\
&\times \frac{P_7^s - P_n^s + \text{Odds} \times \left( P_7^s - P^s_{\text{Pay}} \times P_n^s \right)}{P_n^s + P_7^s} \\
\therefore \text{Exp} &= \frac{\text{Earn}}{1 - P_{12}^c + \text{Odds} \times \left[ \text{Pay}^{410} \times \left( P_4^c + P_{10}^c \right) + \text{Pay}^{59} \times \left( P_5^c + P_9^c \right) + \text{Pay}^{68} \times \left( P_6^c + P_8^c \right) \right]} \\
\end{align*}
\]

• Small odds wagers are assumed in the equations below (i.e. odds bet = wager, such that potential payout on the odds bet is less than the wager). This method is usually used in books in representations of the edge for don't pass bets. This is not actually how casinos generally accept odds bets though (usually allow odds on don't bets such that the payout is the original wager, as done above). This means that the house edges published in most books for don't bets with odds are too low, not reflecting the actual potential edge a player can get.
\[ \therefore \text{Earn} = P_2^c + P_3^c - P_7^c - P_{11}^c + P_{12}^c \times 0 + P_{pt}^c \times \]
\[ \left[ \text{ExpPt}^{410}_4 + \text{ExpPt}^{410}_10 + \text{ExpPt}^{59}_5 + \right. \]
\[ \left. \text{ExpPt}^{59}_9 + \text{ExpPt}^{68}_6 + \text{ExpPt}^{68}_8 \right] \]

Where, \[ \text{ExpPt}_n^s = \frac{P_n^c}{P_{pt}^c} \times \]
\[ \left[ P_7^s - P_n^s + \text{Odds} \times \left( \frac{P_7^s}{\text{Pay}_n^s} - P_n^s \right) \right] \]
\[ P_n^s + P_7^s \]

\[ \therefore \text{Exp} = \frac{\text{Earn}}{1 - P_{12}^c + \text{Odds} \times P_{pt}^c} \]
How Smart Craps Works

*Smart Craps* has a very rich and powerful setup that allows you to model just about any scenario in the game of craps. Before you begin using the program, make sure you understand how *Smart Craps* models craps games.

**Smart Craps Wizards**

Setting all the options for *Smart Craps* simulations can be daunting. The two *Smart Craps* wizards are for those who want to 'fast-track' into the program without learning all the details. While not all the complexity and features are exposed by these wizards, they will get you going quickly and give you a great starting point to explore the options some more.

*Pro Test Wizard*

Most dice controllers want to know two things: how much money can I make, and what are the optimal dice sets for different bets. The Pro test wizard is the fastest way to answer these questions. The wizard will guide you step by step through taking a Pro Test, entering your results, choosing a bet, and seeing your edge and optimal dice sets. It will even setup *Smart Craps* so that you can confirm your edge through simulation.

All the steps in the Pro Test wizard are fully documented. Just follow the instructions in each dialog.

*Simulation Wizard*

This wizard will guide you step-by-step to create basic simulations. You can specify any number of shooters, using random, SRR, or Pro Test throwing styles. You can choose different bets, and craps game options.

After the wizard is done, you can run the simulation, or explore the settings how *Smart Craps* works.

**Smart Craps Settings**

This is just a quick introduction to the setup of options in *Smart Craps*. All five of these options on the main screen are available in the 'Settings' menu as well. For more detailed help, press 'F1' to get
specific information on the options presented in any dialog or screen.

In the middle of the main program screen, there are five settings buttons:

![Figure 9: Smart Craps settings]

**Table settings**

*Smart Craps* models one craps table in its simulations. Like a real craps table, *Smart Craps* lets you have more than one player, who each starts by throwing the dice in hands until he or she sevens-out on a point, after which the dice are passed to the next player.

The table consists of a number of spots, at which shooters can stand and bet. The table in the simulation needs at least one spot, but can have as many as you want. A spot represents a place where shooters can come up and bet.

For each spot, you can designate one or more walkups, who are potential shooters who may come up to the table and play. When the dice pass to a new spot, one of the walkups for the spot will randomly decide to play for a while. They may play for a number of designated dice rolls until they seven out on a point, or they will stay in the spot forever once they start playing. You, the person running the simulation, may bet with the walkup (i.e. mirroring their bets), bet on their throws using your betting system, or not at all.

**Shooter settings**

Each walkup represents an individual shooter with a specified amount of skill. They can be a random shooter with no dice control skill, an SRR shooter, or a Pro Test shooter. In the later two cases, you specify the skill levels they have, and this is used when they roll the dice in the simulation or edge calculators.

**Betting settings**

Each shooter uses a specified betting system to place bets in the game and determines their dice sets (if applicable). You can have as many or as few betting systems as you want. Shooters can reference the same betting system or each use their own. Each betting system is a type of Betting Module. The default betting module in *Smart Craps* is the 'Flat Betting Module', which lets you model and test individual bets. Additional betting modules are available to test different and more
complicated betting systems. Contact info@deepnettech.com for more information or visit the *Smart Craps* web site (http://www.SmartCraps.com).

Each betting system, dependent on the module, has different parameters and settings. Ultimately, the role of the betting system is to tell the simulator what bets to make and when, and what dice sets to use. Dice sets only apply when a Pro Test shooter is using the betting system, and are ignored otherwise (in practice SRR shooters use dice setting to influence the outcomes, but the measurable effect is only the frequency of sevens).

**Craps settings**

All the specific rules of the game at the table are defined in the *craps settings*. The bet minimum and maximum, odds, payout schedule, and unusual rules are defined here (such as how vig and commissions are handled).

**Simulation settings**

Before you run a simulation, click on *simulation settings*. You can specify how many rounds to runs, output files and format.

**Simulation**

Once you have set all the options, you are ready to run a simulation. The simulation options are available in the main screen.

![Simulation](image)

**Figure 10: Running *Smart Craps* simulations**

To begin running a basic simulation, just click on the *Run sim* button. The simulation will continue until the requested number of round of craps has been played or you cancel the operation. A report is created at the end of the simulation, which you can view by clicking the on the *View report* button. See the ROR Simulations »Page 115 section for more information on the last button in this group.

**Calculators/Tools**

In addition to the simulation features in *Smart Craps*, you have access to a number of powerful mathematical tools that can instantly help refine your game.
The **Dice set optimizer** button is a powerful tool that can help you determine your edge with any bet based on your dice control skill, or help you improve your dice sets to maximize your earnings potential based on your level of skill. This is done strictly with mathematical computations, not simulation (see the 'Pro Test Edge »Page 45' section for a more detailed explanation). Once you have rolled the dice enough to pass the Pro Test and prove your talent, you may be surprised to learn your earning potential, or better dice sets.

The **ROR Calculator** button lets you determine the financial risk of winning or losing based on short or long term play sessions (see the 'ROR Calculator »Page 102' section for more details).

The **Pro Test solver** lets you quickly determine whether your throw results represent passing Pro Test values. Find out the passing requirements for different numbers of rolls (see the Pro Test Solver »Page 107 section for details).
Simulation Settings

Click the 'simulation' button on the main screen to bring up the 'Simulation settings' dialog.

![Simulation settings dialog]

Use the options in this dialog to set the main simulation features.

**Number of rounds**
This is set to the number of rounds in the simulation, in thousands. For example, 100,000 represents 100 million rounds. Generally, you should run a minimum of 10 million rounds for reasonably accurate results, and 1 billion rounds for extremely accurate data. 100 million rounds is generally a reasonably number of rounds for accuracy to one decimal place for edge percentages.

**Type of rounds**
This can be set to one of three options:

- **Throws of the dice**: The simulation will be stopped after the dice are thrown the number of rounds. Note that the current shooter's
hand will be completed (i.e. wait until he sevens-out) before the simulation is stopped. Depending on the bet options, this may mean many more bets than the number of rounds, but less shooter hands.

- **Hands for each shooter:** The simulation will be stopped after that many shooter hands are completed. A hand is the sequence of throws prior to the shooter sevening out. Depending on the bet options, this may mean many more bets than the number of rounds, and many more dice throws.

- **Bets placed in sim:** The simulation will be stopped after that many bets are placed. Note that the current shooter’s hand will be completed (i.e. wait until he sevens-out) before the simulation is stopped. The number of dice throws may be much higher.

**Debug output**

This can be set to one of three options:

- **No debug output:** The simulation result file will contain only statistical summary information; no data on the actual dice throws and rolls.

- **Yes, first 10,000 throws only:** The simulation result file will contain detailed throw-by-throw dice and betting information for the first 10,000 rolls, and then the simulation will be stopped. This useful feature allows you to see exactly how Smart Craps works and check the results.

- **Yes, for all rounds in sim:** The complete simulation result file will contain detailed throw-by-throw dice and betting information. You should use this option with caution, since the resulting report file can be extremely large (and fill your hard drive) for large number of rounds.

**Output file**

Specify the output file on this line. You can use the 'Browse' button to use a file browser to choose or specify a file. If you leave off the path information, the output file will be in the Smart Craps installation directory. If you leave off the file extension, either '.html' or '.txt' will be added based on the 'Output file type' option setting. If you do not specify any file name (i.e. leave it blank), the name is based on the save-name »Page 109 for the simulation. If the current simulation has not been saved, then 'smartcraps' is the default output file name.

**Overwrite file**

This can be set to one of two options:

- **Append # to file name to make unique:** An underscore followed
by a unique identifying three digit number (with zeros in front) will be tacked on to the end of the file name, if it already exists.

- **Overwrite if output file exists:** If the output file name already exists, it will be erased and replaced with the new result file from the simulation.

**Output file type**
This can set to one of two options:

- **Text file:** The simulation result file will be a text file suitable for viewing in any text editor. When you view a simulation report with this option, the Windows Notepad program is started to view the file.

- **HTML/web file:** The simulation result file will be an HTML file suitable for viewing in any web browser. When you view a simulation report with this option, the current web browser program is started to view the file (i.e. Windows Internet Explorer).

**Random number generator**
*Smart Craps* uses a random number generator to roll the dice in simulations. A random number generator is a special computer algorithm that ensures the distribution of rolls is the same as if a person rolled perfectly random dice. There are two ways *Smart Craps* can generate the random numbers it uses:

- **Different random sequence for each simulation:** Each time you run the simulation, a different random sequence will be used and the results will be different.

- **Same random sequence for each simulation:** Every time you run the simulation, you will get the same exact results (assuming the same exact settings). As long as you run enough rounds, the results will reflect accurate statistics. To achieve this, the random number generator uses a 'seed' value that determines the exact sequence of generated numbers. The seed is set at the start of the simulation. If you enter a different random seed, then the sequence will be completely different. The actual seed value is irrelevant, and has no impact on the starting point for the random sequence. You most likely will not need to change the random seed value.
Craps Game Settings

Click the 'Craps' button on the main screen to bring up the 'Craps game settings' dialog.

Use this dialog to set the craps rules and game options. There are subtle differences in rules between casinos, which are determined by the options in this dialog.

**Table limits**
Simulations in *Smart Craps* are always in dollars. Set the minimum and maximum bet sizes in this section. Check the 'no limit on top bet' option if you want to allow bets of any size. The limit options do not determine the actual bet sizes made: the bets are determined by the Betting Systems »Page 64 used in the simulation. But, any bets made below or above these limits will be flagged in the report file as warnings or errors.

**Odds allowed**
Use this option to model the odds provided in the simulation, if any.
Odds apply only to pass line/come and don't pass/don't come bets. For example, setting the odds to '10' means that a betting system can place a follow-up odds bet up to tens times the original wager on pass line and don't pass bets. The odds option does not actually mean that odds bets will be placed: all bets are determined by the Betting Systems »Page 64 used in the simulation. But the maximum allowable odds bets are governed by these options.

- **Odds bets over table maximum**: Uncheck this option if you want odds bets to be capped by the applicable table limit (if any). This is particularly relevant for don't pass bets, where the odds wager can be much larger than the original bet, even with single odds.

All bets are placed by the Betting Systems »Page 64, including odds bets. Depending on the system settings, there are two ways that odds bets can be placed: specifically, or automatically. Generally, you'll want the simulation to either not place odds bets at all, or determine the correct maximum odds bet allowed for you and place them. In the latter case, the actual size of the odds bets is calculated by the additional settings below:

**Round automatic odds bets**

Odds bets, as well as many proposition bets such as placing points, are different from the initial pass/don't pass wagers in that they do not win (payout) in even dollar amounts. This is similar to the 3:2 payout in blackjack for a natural 21. This can present problems when you win such a bet, depending on the original wager. *Smart Craps* has different options for handling these situations.

To see this in action, consider a $5 pass line bet in a casino with single odds. On the come out roll, you get 5, and want to follow up with the maximum allowable odds (to minimize the house edge), which technically, is another $5 odds bet. Now, suppose you make the point (i.e. roll a five before a seven), and win the wager and the odds bets. The casino is supposed to pay you 3 to 2 on odds bets for the 5 and 9 points. That would be $7.50, which is a problem if the casino does not use 50 cent chips in the craps pit.

- **Round down for whole payout**: With this setting, your actual odds bets will be rounded down prior to being placed such that the actual payout, if you win, is to the nearest dollar. In the example above, the $5 odds bet would be lowered to $4. If you made the point, then you would win $5 on the original pass line bet, and $6 on the $4 odds bet.

- **Leave as bet**: With this setting, your odds bets are not altered at all. This may cause rounding problems in the payout, which are noted in the report file. See below for how the software handles
uneven payouts.

- **Up for payout to the nearest->:** With this setting, your odds bets are increased so that the payout, if you win, is to an even amount. The field beside this one specifies the payout rounding, which is normally one dollar. In the example above, the $5 odds bet would be increased to $6. If you made the point, you would win $5 on the original pass line bet, and $9 on the $6 odds bet. Notice that this option may increase your odds bet over the normal odds for the game. This is actually how most casinos handle this situation: you may generally increase your odds bets to allow an even payout.

Some casinos prefer not to return dollar chips, especially at $5 and higher limit pits, and may round odds up to higher amounts. For example, suppose you make a $15 pass line bet in a minimum $10 game with single odds, and roll a 6 point. With exactly $15 in odds, the 6 point would pay 6 to 5, or $18. Some casinos may allow odds bet to be rounded up to payout to the nearest $5. Hence, they would accept a $25 odds bet on the original $15 wager. A $25 odds bet on the 6 point would payout \( \frac{6}{5} \times 25 = 30 \). If this is the case, then set the rounding field to 5 to reflect the fact that the casino rounds up your bet to payout to the nearest $5. This is advantageous to the player, as better odds decreases the house edge significantly.

The automatic odds setting only apply to odds pass line bets, not proposition and lay bets (which are odds bets on the don't pass bets). Proposition bets simply use the exact bet amount specified (the rounding field above is ignored). For lay bets, it depends on the betting system settings. As with pass line odds bets, if the betting system says to make the lay wager with an exact amount, then it is not altered.

But if the betting system says to place the maximum automatic odds bet, then the maximum lay bet is computed based on the don't pass wager. The lay bet amount will be larger than the original bet to the nearest dollar, such that payout if you win is at least the original wager, and is also an even dollar amount. For example, suppose you bet $5 on don't pass, with single odds, and you roll a 9 point. The exact lay bet to return $5 with 2 to 3 lay odds is $7.50. So, *Smart Craps* will round up the lay bet to the next even dollar amount that provides exact odds. In this case, a $9 lay bet would be placed which returns \( \frac{2}{3} \times 9 = 6 \) on a win (meaning, a seven is rolled prior to the 9 point number). The rounding options are not used for computing the maximum automatic lay bets.

**Uneven payouts**

Depending on your wagers and settings, *Smart Craps* may have to pay you on a bet that does not work out to the exact dollar. This can
happen if the betting system uses specific amount bets for odds and lay bets, or it sets some proposition bets. For example, suppose you make a $10 bet to place the 6. Normally, the pit crew in a real casino might ask you to increase the bet to $12 for an even payout if you win, but they may also accept the bet as is. If you do win on a $10 bet, how much will you be paid?

In the case above, the casino will pay you 'true odds' on the even portion of the bet, and 1 to 1 odds on the remainder. For your $10 wager, you will be paid $7 (7:6) on the first six dollars of the bet, and $4 on the remaining portion, totaling $11. Notice that $10 * 7 / 6 = $11.67, so you are losing over 50 cents on this bet! Gamblers should always avoid making bets with uneven payouts. Any payout in *Smart Craps* that results in rounding like this is added as a warning in the report file.

**Vigorish/Commission**

Buy bets in craps involve paying the casino a commission, since you are getting 'true odds' on the wager. The commission is a percentage of your initial wager, usually 5%. These commissions are called 'vigs', short for 'vigorish'.

- **Pay commission when you lose as well as win:** Some casinos will return the vig to you if you do not win the bet. This is obviously preferable for the player, but not always available. Check this option if the casino makes you pay the commission, win or lose.

- **Commission leeway:** What happens if 5% of your wager does not round to the nearest dollar? Different casinos will handle this in different ways, which can be more favorable to the player. The leeway setting determines the 'crossing point' over which the casino will round up the commission to the next dollar amount. For example, suppose the casino only charges you a $1 vig on a $35 buy bet, but would charge you $2 on $36 wager. The leeway in this case is '15', meaning that as long your bet is with $15 of the $20 exact amount (5% of $20 is exactly $1), then the vig is $1. Similarly, you would have a $2 commission on bets up 40+15 = $55, and $3 for $56. Some casinos are very liberal, and would only charge you a $1 vig on bets up to and including $39. In this case, the leeway is 39 - 20 = 19.

- **Vig increment:** Since commissions are small relative to the bets made, some casinos round the vig to the nearest 50 cents and use appropriate chips. If this is the case, change this option. Note that the leeway option above changes to be to the nearest 50 cents. For example, a leeway of '9' means a $29 bet has a $1 vig, while $30 has a $1.50 commission.

**Bet Odds**
Use this button to set the specific odds for the proposition bets. This can be useful if the casino uses a slightly different pay schedule from the normal defaults.

![Bet odds](image)

Use this dialog to set the payout schedule for the different bets in craps. While these defaults are most common, you may find a few casinos with slightly different odds for different bets. The simulation results will not actually be affected unless the betting systems you are using actually place these proposition bets.

To restore the default bet odds, click the ‘Default’ button.
Betting Systems

Click the 'Betting' button on the main screen to bring on the 'Betting systems' dialog.

Betting systems in *Smart Craps* define a style of betting and dice setting for a shooter. For a general overview of the simulation structure used in *Smart Craps*, see the How Smart Craps Works »Page 52 section.

**Available betting systems**

The main list displays the betting system you have created. It is important to understand the difference between **betting systems** and **betting modules**. *Smart Craps* comes with one or more betting modules that can be used to create betting systems. A betting system is an 'instance' of a betting module with all the options set. For example, the Flat Betting Module »Page 67 can be used to make betting systems to test basic individual craps bets. Suppose you want
to run simulations to test two different kinds of bets (say, pass and place bets). To do this, you need to create two betting systems, and set the options for each to test the two different bet types. Then, you can create shooters that use these betting systems.

**Available betting systems**
The main list displays the betting system you have created so far. The names for the systems are completely up to you, as long as they don't overlap. The list shows both the betting system name, and the betting module it derives from. To select a betting system, click on its name in the first column (not the betting module).

**New Betting System**
Click this button to create a new betting system.
In the top field, enter a descriptive name for this system. A good guide is to use a name that reflects the betting style or options for the system.

Each betting system must derive from a Betting Module »Page 52. One or more betting modules come with Smart Craps, and additional betting modules are available at our web site: (http://www.SmartCraps.com). See the Module sections Flat Betting »Page 67 and Script Betting »Page 70 for more information on the two betting modules that come with Smart Craps.

When you select different betting modules, an explanation of the betting module is shown in the dialog. 'Flat Betting' is the default betting module that Smart Craps comes with.

**Edit Betting System**

Use this button to edit the characteristics of the selected betting system. The dialog of options that is displayed depends on the derived betting module. See the section Flat Betting Module »Page 67 as an example of the edit options for a betting system.

**Delete Betting System**

Use this button to delete the selected betting system. You are prompted for confirmation before the system is deleted.

**Rename Betting System**

Use this button to rename the selected betting system.

The name of the betting system is only for your own guidance. You can use a descriptive text string that helps you understand what the betting system is intended to do.
Flat Betting Module

The following dialog is displayed when you edit a betting system based on the Flat Betting Module.

**Bet type**
Select the type of bet you want to make. The standard craps bets are available in the drop list. Come (and don't come) bets are not included since pass and don't pass bets are available.

**Point**
If the bet you have selected requires a point, select it here. For example, if you want to make place bets on the eight, select '8' here. This option is not relevant to some bets, such as pass and don't.

**Bet Frequency**
By default, the bet will only be made on the come out roll. This effectively tests one bet at a time in every point cycle, which is usually what you want to do. Alternatively, you can place the bet every
possible chance you get, even if prior bets are not resolved.

For example, if you choose to make a place bet on every roll, additional bets will be made during the point cycle until you make the point or roll a seven. This can be very risky and costly, since your total wagers will accelerate as the point cycle goes on. You will see the edge vary more during simulations with this option.

This option only places bets when they are allowed. For example, pass and don't bets can only be placed on the come out roll anyway.

**Odds**

These options only apply to pass and don't bets. They are ignored with other bet types.

- **No odds:** No odds follow-up bets will be made. This is identical to playing with zero odds.

- **Follow with maximum odds allowed:** The maximum odds bet will be placed, according to the craps game settings (see the Craps Game Settings »Page 59 section). This does not necessarily mean that odds bets will be placed, if the craps settings do not allow odds. Double check the craps game settings to confirm the odds options.

- **Follow up with specified odds:** Specific odds wagers will be placed after every pass or don't pass bet. Enter the odds wager on the line below this option. This option can result in simulator warnings if the odds wager results in uneven payouts. For example, if the minimum bet in the craps game settings is $5, and you set the odds wager to $5, then a pass line bet with a 5 or 9 point should pay 3 to 2, resulting in an uneven payout (which will be $7, not $7.50 as it should be). Make sure you specify a large enough odds wager that results in even payouts for all points, based on the bet size.

**Bet amount**

- **Bet the table minimum:** The wager will be whatever the table minimum is set to (see the Craps Game Settings »Page 59 section).

- **Bet a specified amount:** You can bet a specific amount with every bet instead. Enter the wager size in the line below this option. You may get warnings when you run the simulation if the bets are smaller or larger than the table limits.

- **Working on come out rolls:** Check this option if you want all bets to be working on the come out roll. By default, many bets are not 'on' by default on the come out roll, including place, buy, hardway, and come bets. For example, suppose you make a place bet on the
eight during a point cycle. The shooter's point is a 6, and they make the roll before rolling an eight or seven. Normally, your place bet is not working on the next come out roll. This means if the shooter rolls a seven or eight, nothing happens to your place bet. If you instead say that bet is always working, then the place wager would be resolved on that come out roll.

**Dice sets**

These options are only relevant when the shooter using this system uses a Pro Test throwing style »Page 84. See the section Dice Sets »Page 97 for more information on the notation used in the drop down lists.

- **Same dice set for all throws:** Select a single dice set to use for all situations.

- **Dice sets by table state:** Using a single dice set for all situations does not usually lead to the maximum player edge. Generally, depending on your skill, you'll want to use different sets depending on the point you are going after, or if it is the come out roll. Select the dice set for each of the four unique situations or table states.

**SRR shooters**

These options are only relevant when the shooter using this betting system uses a SRR throwing style »Page 87.

- **Come out roll:** You can decide what method of rolling the SRR shooter uses on the come out rolls. There are three choices: minimum SRR (greatest number of sevens), maximum SRR (least number of sevens), and random. Use the latter option to indicate a completely random roll. Note that a 'minimum' SRR actually means the maximum actual SRR fractional value (we are minimizing the second number in the ratio).

- **Point rolls:** You can decide what method of rolling the SRR shooter uses on all point rolls. There are three choices: minimum SRR (greatest number of seven), maximum SRR (least number of sevens), and random. Use the latter option to indicate a completely random roll.

How you set these options depends on the bet. With a pass line bet for example, you will want the minimum SRR on the come out roll, and maximum SRR for the point rolls. For don't bets, you want the exact opposite. The actual SRR values used are defined with the shooter using this betting system »Page 64.
Script Betting Module

This component is the ultimate power-user add-on for players wanting to test their own individual betting systems. This betting module lets you program any possible betting and dice setting system in BASIC (Microsoft VBScript), which Smart Craps then executes as part of the simulation.

Before You Get Started with Script Betting…

Programming your own script betting systems is not for the timid… there’s a lot to learn, and it does involve some simple BASIC programming. Before reading the actual user's guide after this section, please check these questions and answers to make sure the Script Betting Module is for you.

How does it work?

You program your betting system in VBScript, which is a feature-rich subset of the common BASIC programming language. All you have to do is tell Smart Craps what file the betting system script code is in, and it takes care of the rest. Smart Craps will call into the script code everytime there is a betting opportunity, letting your script decide what bets to place (if any), and what dice sets to use.

The VBScript interface has been extended to let you reference the craps game state. For example, you can implement a progression betting system by looking at the current bankroll, and determining the next bet size accordingly. Or, you can see how dice throws the current shooter has made, to see if they are worth betting on. A wealth of statistical and state information is available for you to query from the script code. Plus, you can use all the features of VBScript, including functions, subroutines, expressions, etc.

What do I need to know to use the Script Betting Module?

If you have never programmed before or are a computer novice, then this component is probably NOT for you! While we've made programming your own betting scripts as trivial as possible, you still need to be able to write code in the BASIC language. If you have a bit of experience in programming (any language), and are experienced using Windows computers, then the Script Betting Module will easy for you to use. The BASIC programming language is very simple, and easy to pick up for novices.

Can I try it out before buying it?

Yes. The Script Betting Module is included in the regular Smart Craps
installation. There is nothing special to download or run. When you add a betting system, simply change the selection to the Script Betting Module. See the online documentation from the Help menu for more details on using the Script Betting Module.

Are there any examples of how it works?
Check out the Examples »Page 118 section for samples of scripting, or continue reading for detailed instructions on Script Bet programming.

Will this work on my computer? Do I have to install anything?
The Script Betting Module is fully installed by the *Smart Craps* installation program: there is nothing you have to do manually. It works on all Windows 98 and higher desktops. *Smart Craps* uses the free VBScript engine that is included with the Windows operating system and/or Internet Explorer browser.

Script Betting Settings
The following dialog is displayed when you edit a betting system »Page 64 based on the Script Betting Module.
**Script file**

This is the file name containing the VBScript betting code. If you do not specify a full path, then the file is searched for in the *Smart Craps* directory. Click on the 'Browse' button to find and select a specific file.

Click on the 'Edit file' button to bring up the default Windows NotePad editor on the script file. If the file does not exist yet, then you will be prompted if you want to create it. You can use any text file editor though to edit the script files.

Click on the 'Check script' button to have *Smart Craps* test the code for errors. In computer language terms, the script file is *interpreted*, but not
run, to make sure it has no syntax errors. It is possible to get errors when you run the simulation, even if the script passes the check here. If the script does have errors, a dialog is displayed with the error information. The script is also checked when the Script Betting dialog is closed.

**Bet/Dice set subroutine**

*Smart Craps* will call this script sub routine on every unique betting opportunity in the game (i.e. before every throw of the dice). This is where you should place the code that determines what bets to place, and dice sets to use (see the next section for details in coding this section).

**Simulation start/end subroutines**

You may specify the names of subroutines in your script that are called once at the start and end of the complete simulation. These are optional (leave blank if not used). This can be handy for setting global variables for your betting script.

**Walkup start/end subroutines**

You may specify the names of subroutines in your script that are called once at the start and end of each walkup’s hand. These are routines are optional (leave blank if not used). This can be handy for setting global variables for your betting script.

The walkup start routine is called just before the dice are passed to a walkup who enters the table, and before they throw the dice. This may be a new shooter, or the same shooter as previously, depending on your simulation settings. When they seven out and pass the dice to the next shooter, the end routine is called.

**Writing Betting Scripts**

**VBScript language**

You may use 100% of the language features of Microsoft VBScript in your script betting modules. VBScript is a robust subset of the Microsoft Visual BASIC language, giving you access to all programming statements, operators, and other elements. We do not provide or include a reference manual for VBScript with *Smart Craps*: you will need to learn VBScript on your own if you are not familiar with it. But, here are some useful web links with documentation on VBScript:

- Microsoft VBScript: The complete User’s Guide and Reference Manual for VBScript from Microsoft. Although terse, this site provides a complete list of all language features in VBScript.
• http://www.q-tek.net/scripting/docs/Vbstutor.htm: A simplified version of the main Microsoft VBScript documentation. A bit easier to use and navigate.

• www.amazon.com: If you search the Amazon book store for 'VBScript', you will find many programming books. Stick to basic guides, and avoid references for particular server side and unusual applications (such as web WSH programming).

• http://www.w3schools.com/vbscript/default.asp: A nice introduction to VBScript, but targeted at it's usage in web pages. But most information is equally applicable to embedded usage.

The script file
The script file can be any VBScript file. You can include your own code, globals, constant, functions and subroutines. Smart Craps calls the subroutines directly that you specify. These subroutines can call other routines and functions.

Debugging your script files
Any significant script is going to have problems initially. While we do not provide a 'live' script debugger, you can use 'print style' debugging to test your scripts.

The easiest way is to use the 'SCState.AddDebugLine' extension to print output lines into the Smart Craps report file. These are only output if the 'Debug Output' option in the Simulation settings is set to 'yes'.

Alternatively, you can use the VBScript 'MsgBox' function to print out information as the script is executed. Note that this will pause the simulation until you close the message box.

Multiple script betting systems
An unique 'instance' is created for each script betting system. This instance will get it's own state and variable context. Hence, if you have two different script betting systems, the global variables in each are unique and independent. But, the SCState craps information is commonly accessible to both.

If more than one shooter or walkup refer to the same betting system, they will all share the same instance. This means they will share the same globals name space across different shooters.

Speed of execution
Craps simulation is a very CPU intensive process. 10 of millions of rounds of craps equals trillion of computer operations. The betting script function is called before every dice throw, since that is when a player can place a bet in craps.
The end result is that using script betting slows down execution of craps simulations significantly. You should expect the simulations to run anywhere from 30 to 100 times slower (than native flat betting modules), depending on the size of your scripts.

To minimize the speed impact, call as few of the SCState functions as possible in your script, and minimize the amount of Basic VBScript code that is executed. You should especially avoid calling the AddDebugLine function, even if debugging is disabled, since the script line still calls into Smart Craps.

**Bet Script State Extensions**

Every script betting module needs to ask questions about the craps game state to determine what bets to place and dice sets to use. The VBScript interface used by Smart Craps has been extended to include a new embedded ‘SCState’ object that you reference from your code. The SCState variable is a normal VBScript object with properties and methods. In addition, there are a number of pre-defined constants you can reference as well. Here is the complete list of methods, properties, and constants you can reference in any script function (typically the betting function, but these are accessible in all the subroutines).

**SCState properties**

Most SCState properties are read only. You get them, but not set them. The only exception is 'BetWorking', as noted below. The C-style return data type for the property is shown in brackets after the property name and parameters.

- **AddBet( int bet_type, int wager, int point, int auto_odds, int working_on_come_out )** (int bet_id): This parameterized property is called to place a bet into the simulation. 'bet_type' is one of the 'BET_TYPE_…' constants (see below). 'wager' is the bet is dollars, or -1 to place the table minimum bet. 'point' is point number for the bet, if applicable. If 'auto_odds' is True, then the bet will be followed with the maximum odds bet allowed, if applicable for the bet type and odds are allowed in the simulation settings. If 'working_on_come_out' is True, then the bet will be working on come out rolls, if applicable for the bet type. This property returns a special 'bet_id' identifier, which can be used with the 'AddOddsBet' function. Note that AddBet is not a function, but a property, since it returns a bet id. This means you cannot call it like a routine: you must assign it's return property value. Example:

  ```vbnet
  betid = SCState.AddBet( BET_TYPE_PASS, -1, 6, True, True )
  ```

- **BetWorking( int bet_id )**(short): returns 1 if the specified bet is
'working' right now (on come out rolls), or 0 otherwise. The 'bet_id' is returned from the 'AddBet' property. You can change this property. Example:

```csharp
if not SCState.BetWorking( LastBetId ) then
    SCState.BetWorking( LastBetId ) = True
End if
```

- **CrapsTableMax** (int): Returns the current setting for the maximum bet size.
- **CrapsTableMin** (int): Returns the current setting for the minimum bet size.
- **GameStateComeOutRoll** (short): returns 1 if the next roll is a come out roll, 0 otherwise. This should be called only from the betting subroutine. Example:

  ```csharp
  if SCState.GameStateComeOutRoll then
      ComeOut = ComeOut + 1
  end if
  ```

- **GameStatePointSum** (int): Returns the current point for the shooter, if the shooter is not on the come out roll. Example:

  ```csharp
  If( ( not SCState.GameStateComeOutRoll ) and
      SCState.GameStateSum = 6 ) then
      betid = SCState.AddBet( BET_TYPE_PLACE, -1, 6,
                             False, False )
  end if
  ```

- **ShooterName** (string): Returns the name of the current shooter.
- **ShooterNumRolls** (long): The total number of rolls by this shooter since the start of the simulation.
- **ShooterRollsByCombo(int die1, int die2)** (long): The total number of rolls of the specified dice combo made so far in all situations by the current shooter. At the start of the simulation, all combos will return zero.
- **ShooterRollsBySum(int sum)** (long): The total number of rolls of the specified sum made so far in all situations by the current shooter. At the start of the simulation, all sums will return zero.
- **ShooterThrowsPerHand** (double): The average number of dice throws per hand for the current shooter since the start of the simulation. Example:
If SCState.ShooterThrowsPerHand > 10.5 then
    betid = SCState.AddBet( BET_TYPE_PLACE, -1, 6, False, False )
end if

- **ShooterThrowStyle** (short): The throwing style for the current shooter. One of the 'ROLL_...' constants (see below).

- **StatsBankroll** (double): The current sum of all wins and losses, in dollars. In effect, the bankroll starts at zero when the simulation begins, and goes up or down from there.

- **StatsCurrentBankroll** (double): The current sum of all wins and losses, in dollars, where all bets are removed immediately when placed. This models casinos more accurately than the StatsBankroll function. The two functions end with the same bankroll at the end of any hand (when all bets are resolved), but can be different in between hands as bets are on the table. All bets, including odds, are removed from the bankroll immediately, with the exception of the vig which is only removed as the commission bet is resolved.

- **StatsNumBets** (long): Returns the total number of bets made so far in the simulation by all shooters.

- **WalkupNumRolls** (long): The number of dice throws so far for the current shooter in this hand. At the start of a hand, this value is zero.

- **WalkupRollDie1( long roll_num )** (short): Returns the left die roll of the specified roll number in the current shooter's hand. 'roll_num' is zero origin. 'roll_num' must be less than the value returned by WalkupNumRolls.

- **WalkupRollDie2( long roll_num )** (short): Returns the right die roll of the specified roll number in the current shooter's hand. 'roll_num' is zero origin. 'roll_num' must be less than the value returned by WalkupNumRolls.

- **WalkupRollsByCombo( int die1, int die2 )** (long): The number of dice throws so far for the current shooter in this hand for the specified two dice combination. Example:

  \[
  \text{bad_sevens} = \text{SCState.WalkupRollsByCombo}(1, 6) + \\
  \text{SCState.WalkupRollsByCombo}(6, 1)
  \]

- **WalkupRollsBySum( int dice_sum )** (long): The number of rolls of the specified sum so far for the current shooter in this hand. At the start of the hand, all sums will return zero. Example:
Rolls = SCState.WalkupRollsBySum( 7 )

- **WalkupRollSum( long roll_num )** (short): Returns the dice sum outcome of the specified roll number in the current shooter's hand. 'roll_num' is zero origin. 'roll_num' must be less than the value returned by WalkupNumRolls. Example:

  Rolls = SCState.WalkupRollsBySum( SCState.WalkupNumRolls - 1 )

**SCState methods**

All methods have no return value.

- **AddDebugLine( str )**: Adds a line of text to the output file for the simulation. These lines are only output if the 'Debug Output' option in the Simulation settings is set to 'yes'. Make sure you comment out these lines when you are done writing and testing your script. Even though they cause no output with non-debug simulation runs, they will slow down the execution all the same. Example:

  Str = "come out: " & SCState.GameStateComeOutRoll 0 SCState.AddDebugLine( Str )

- **AddError( str )**: Adds an error to the output file. Errors are also shown on the simulation done dialog. Once you add one or more errors, the simulation will be terminated immediately when you return. Errors always show up in the output file (not dependent on the output type options).

- **AddOddsBet( int bet_id, int bet_type, int wager)**: Adds an odds bet for an existing pass, don't pass, come or don't come bet. At least one roll must have been made after the initial bet was placed (since odds can be placed only after the point is established). The 'bet_id' is the value returned from the 'AddBet' property. 'wager' can be -1 to place the table minimum bet for the simulation craps settings. The 'bet_type' is one of the 'BET_TYPE_...' constants (see below). Example:

  SCState/AddOddsBet( LastBetId, BET_TYPE_ODDS, -1 )

- **MakeTip( int tip )**: Deducts the specified tip amount from the bankroll. This can be used to model the true cost of tips. This counts as a betting action.

- **AddWarning( str )**: Adds a warning line to the output file. Warnings are also shown on the simulation done dialog. Warnings always show up in the output file (not dependent on the output type options).

- **SetDiceSet(int die1_set, int die2_set )**: Establishes the dice set to
use on the next throw. This setting is only observed if the next dice throw is by a Pro Test shooter. The values for 'die1' and 'die2' are the 'DIE_SET_...' constants (see below).

- **SetSRRRollType(int roll_type):** Establishes the SRR roll type to use on the next dice throw. This setting is only observed if the next dice throw is by a SRR shooter. The values for 'roll_type' are the 'SRR_ROLL_TYPE_...' constants (see below).

### Predefined constants

These constant values are defined outside of the betting script, and can be referenced at any time from your code. The actual numeric value is shown in the brackets. But, you should never use the actual numeric values directly, instead entering the constant names.

**BET_TYPE_...:** used by the AddBet property and AddOddsBet subroutine. Note that some bets are invalid on come out rolls (odds bets), and will cause an error in the report if made otherwise.

- BET_TYPE_PASS (0)
- BET_TYPE_DONT_PASS (1)
- BET_TYPE_ODDS (2)
- BET_TYPE_LAY_ODDS (3)
- BET_TYPE_COME (4)
- BET_TYPE_DONT_COME (5)
- BET_TYPE_PLACE (6)
- BET_TYPE_BUY (7)
- BET_TYPE_LAY (8)
- BET_TYPE_FIELD (9)
- BET_TYPE_BIG_68 (9)
- BET_TYPE_HARDWAY (10)
- BET_TYPE_ANY_SEVEN (11)
- BET_TYPE_ANY_CRAPS (12)
- BET_TYPE_CRAPS_2 (13)
- BET_TYPE_CRAPS_3 (14)
- BET_TYPE_CRAPS_12 (15)
BET_TYPE_YO_11 (16)

**DIE_SET_...**: used by the DiceSet function. Note that you can specify the same die set by two different orientations.

DIE_SET_T1_L2 (0)  
DIE_SET_T1_L3 (1)  
DIE_SET_T1_L5 (2)  
DIE_SET_T1_L4 (3)  
DIE_SET_T2_L1 (4)  
DIE_SET_T2_L4 (5)  
DIE_SET_T2_L6 (6)  
DIE_SET_T2_L3 (7)  
DIE_SET_T3_L1 (8)  
DIE_SET_T3_L2 (9)  
DIE_SET_T3_L6 (10)  
DIE_SET_T3_L5 (11)  
DIE_SET_T4_L1 (12)  
DIE_SET_T4_L5 (13)  
DIE_SET_T4_L6 (14)  
DIE_SET_T4_L2 (15)  
DIE_SET_T5_L1 (16)  
DIE_SET_T5_L3 (17)  
DIE_SET_T5_L6 (18)  
DIE_SET_T5_L4 (19)  
DIE_SET_T6_L2 (20)  
DIE_SET_T6_L4 (21)  
DIE_SET_T6_L5 (22)  
DIE_SET_T6_L3 (23)

DIE_SET_T1_F3 (0)  
DIE_SET_T1_F5 (1)
DIE_SET_T1_F4 (2)
DIE_SET_T1_F2 (3)
DIE_SET_T2_F4 (4)
DIE_SET_T2_F6 (5)
DIE_SET_T2_F3 (6)
DIE_SET_T2_F1 (7)
DIE_SET_T3_F2 (8)
DIE_SET_T3_F6 (9)
DIE_SET_T3_F5 (10)
DIE_SET_T3_F1 (11)
DIE_SET_T4_F5 (12)
DIE_SET_T4_F6 (13)
DIE_SET_T4_F2 (14)
DIE_SET_T4_F1 (15)
DIE_SET_T5_F3 (16)
DIE_SET_T5_F6 (17)
DIE_SET_T5_F4 (18)
DIE_SET_T5_F1 (19)
DIE_SET_T6_F4 (20)
DIE_SET_T6_F5 (21)
DIE_SET_T6_F3 (22)
DIE_SET_T6_F2 (23)

SRR_ROLL_TYPE_...: Used by the SetSRRRollType function.
  SRR_ROLL_TYPE_MIN (0)
  SRR_ROLL_TYPE_MAX (1)
  SRR_ROLL_TYPERANDOM (2)

ROLL_...: Returned by the ShooterThrowStyle property.
  ROLL_RANDOM (0)
  ROLL_PROTEST (1)
  ROLL_SRR (2)
Shooters in Smart Craps represent individuals with a specified dice control talent (or none), and a way that they bet. As with a real craps table, shooters may be 'in the wings' waiting to play, or may be in a spot at the table actually betting and throwing the dice. For a general overview of the simulation structure used in Smart Craps, see the How Smart Craps Works »Page 52 section.

Available craps shooters
The main list view shows all the currently defined shooters. The shooter name, betting system they use, and throwing style are displayed in the three columns. To select one, click on the shooter name in the first column (not the other two columns).

New shooter
Click this button to make a new shooter. The current shooter, if one is selected, will be copied to make the new shooter. The text 'copy' will be appended to the name to distinguish it from the original.

**Delete shooter**

Click this button to delete the currently selected shooter. Click on the values in the 'Name' column to select a shooter. You will be prompted to confirm before the shooter is removed.

**Edit Shooter**

Use this button to edit the characteristics of the selected shooter.

**Shooter name**

The name of the shooter is not relevant to the simulation: you can set it to whatever is helpful for you to remember what the shooter does.
**Betting system**
Each shooter uses a betting system to determine his bets and dice sets (dice sets are only relevant to the Pro Test dice throwing style... see below). The betting systems are independent of the shooters, so more than one shooter can use the same betting system.

**Random throw style**
If this shooter does not influence the dice, then click on the 'Random dice throw' option. The remaining options in the 'Throw style' group are not relevant then.

**Pro Test throw style**
Click on this option if the shooter influences the dice outcome and has measured Pro Test results. You should read the Section "Pro Test - a better dice control metric" »Page 29 before using the options in this section. A complete explanation of the three Pro Tests is provided in that section, as well as background information on the statistical derivation of Pro Test.

The options in this section only apply when the Pro test throwing style is selected. The skill of a Pro Test shooter is determined through empirical testing by actually recording throws of the dice (roll sets). These results determine their skill, if any. Read the Recording Roll Sets »Page 41 section for general information prior to using these settings.

- **# of rolls in test:** The number of recorded dice throws in the Pro Test roll set.

- **# of Pro 1 passes:** The number of throws in the roll set that were Pro 1 passes. Using a hardway set (sixes and ones on the outside), a throw is a Pro 1 pass if no six or one shows up. Evidence of dice control skill increases as you get more Pro 1 passes. The number of Pro 1 passes must be less than the number of rolls.

- **# of Pro 2 passes:** The number of throws in the roll set that were Pro 2 passes. Using a hardway set (sixes and ones on the outside), a throw is a Pro 2 pass if it is one of: 22, 33, 44 or 55. Notice that all Pro 2 passes are by default Pro 1 passes. Evidence of dice control skill increases as you get more Pro 2 passes. The sum of the Pro 2 passes and Pro 3 failures must be less than the number of Pro 1 passes.

- **# of Pro 3 failures:** The number of throws in the roll set that were Pro 3 failures. Using a hardway set (sixes and ones on the outside), a throw is a Pro 3 failure if it is one of: 25, 52, 34, 43. A Pro 3 failure is commonly known as a 'double pitch'. Evidence of dice control skill increases as you get less Pro 3 failures. The sum of the Pro 2 passes and Pro 3 failures must be less than the number of Pro 1 passes.
passes.

- **Pro test failed**: If you did not pass the specified Pro Test, then uncheck this corresponding option beside it. This will cause the software to not use this form of bias in rolling the dice and calculating your edge. It is common to pass only a subset of the three tests. For example, only Pro 1, or even only Pro 3.

- **Pro test confidence %**: *Smart Craps* uses the Pro Test values to generate statistically biased roll outcomes in the simulation and edge calculators (see the Pro Test Player Edge »Page 45 section). In effect, it is the ratio of Pro 1 passes to number of rolls that influences the dice outcomes (or ratio to Pro 1 passes, for Pro 2 and Pro 3). Passing a Pro Test is a different statistical metric ("Pro Test - a better dice control metric" »Page 29), which states the probability of a random shooter getting the same result. But even if you do pass a Pro Test, does this mean that the ratio of the Pro Test reflects your exact talent? For example, a Pro 1 Test result of 60 in 100 is a definite pass (0.1263%), but does this mean that you will consistently roll 60 Pro 1 passes for every 100 throws?

60 Pro 1 passes in 100 throws is clear evidence that you are influencing the dice outcomes, but the next question is what ratio of passes is the best and safest reflection of your actual innate ability? Solving this is similar to pre-election poll results, where they state the candidate support from the poll within a margin of error or confidence interval. For *Smart Craps*, the default is to weaken the result (i.e. lower Pro 1 and 2, and raise Pro 3) to yield a 95% confidence that the new Pro test value is accurate. This means that the shooter's actual innate Pro Test value has a 95% chance of being between the weakened value and the same difference on the other side of the actual entered Pro test result. *Smart Craps* calculates the confidence interval assuming a normal distribution for the Pro Test results, and hence uses the following standard normal distribution approximation:

\[
NP = OP - N(.95) \times \sqrt{(OP/n)(1 - OP/n)}/n \times OP
\]

NP = New weakened Pro 1 passes used for simulation and edge calculators
OP = Old/Observed # of Pro 1 passes
N(.95) = Standardized cumulative normal distribution for 95% (1.645)
n = number of rolls (or, Pro 1 passes for Pro 2 and Pro 3 confidence calculations)

Note that this assumes a normalized distribution for the Pro test results. This is actually debatable, since higher Pro Test scores are
much more difficult to achieve. One way to determine whether a normal distribution is a reasonable approximation is to look at the probability distribution for a random shooter:

![Probability Distribution for a Random Shooter, for 90 rolls](image)

Clearly, the probability curves for a random shooter follow a normal distribution pattern centered on the expected value. For the curious, this fact is provable, since it can be shown that the Pro Test probability function is a variant of a binomial distribution, which can be reasonably approximated by a standard normal curve. This is good support that a normal distribution is a reasonable approximation for controlled shooters as well.

More importantly, the purpose of the confidence interval is to simply weaken the Pro Test results so that the player edge is determined with the most conservative possible consideration. This also accounts for the fact that replicating the same level of dice control in a live casino can be much harder than the experimental conditions for the Pro Test. In this sense, any weakening of the Pro test results, whether by confidence interval or simple proportional reduction, is ample and sufficient.

The actual % confidence interval can be changed from the 95% default to anywhere from 70% to 99%. Increasing beyond 95% will further weaken the Pro test values, while using a lower than 95% confidence will provide a smaller reduction (or increase, in the case of Pro 3).

Note that when any Pro Test value is lowered or raised, it will not be weakened beyond the average expected value for a random shooter. If the weakened value is worse than the expected average value for a random shooter, than that test will be disabled.
- **Use test values as is**: If you check this option, then the confidence interval reduction to the Pro Test results will not be applied, and they will be used as is. This option should be used with caution, since the resulting player edge from the simulations and calculators may be too aggressive and not properly reflect what the shooter is capable of achieving. All the same, this setting can be useful when testing marginal Pro Test results that are not passing values, to see what potential edge is possible in the best circumstances. Without setting this option, the Pro test results are likely to be weakened to the statistically expected values for a random shooter, which will not provide any helpful information about the player edge.

- **Check Pro Test scores**: Click this button to see a brief report on the entered Pro Test values. This feature is helpful to see in advance of simulation and calculation whether the Pro Test values pass or not. See the section Pro Test Summary »Page 89 for more information.

- **Pro Test dice set optimizer**: Click this button to go to the dice set optimizer immediately. This is just a short cut to save you from having to leave the shooter dialog and select the optimizer from the main screen. See the section Pro Test Dice Set Optimizer »Page 96 for more information.

**SRR throw style**

Click this option if you want to use the SRR (seven to rolls ratio) to determine how the shooter influences the dice. See the section Seven to Rolls Ratio »Page 27 for more information on SRR.

- **Minimum seven to rolls ratio**: This setting specifies the maximum number of sevens per six rolls that the dice controller is capable of achieving. A random shooter will have a value of 6 (one seven for every six throws). Values from 5.0 to 5.5 indicate a strong degree of dice control. Notice that the actual SRR fraction value is being maximized. It is the second number in the SRR ratio that we are referencing as minimizing.

- **Maximum seven to rolls ratio**: This setting specifies the minimum number of sevens per six rolls that the dice controller is capable of achieving. A random shooter will have a value of 6 (one seven for every six throws). Values from 6.5 to 7.0 indicate a strong degree of dice control. Notice that the actual SRR fraction value is being minimized. It is the second number in the SRR ratio that we are referencing as maximizing.

Generally, a dice setter will attempt to maximize the seven outcomes on the come out (minimum SRR) roll, and minimize the sevens on the point rolls (max SRR). This is modeled in the betting systems »Page 64
Pro Test Summary

Click on the ‘Check Pro Test scores’ button in the Edit Shooters dialog to check the Pro Test results for this shooter. Use the scrollbar to see the complete Pro Test report.

For a general introduction to Pro Test, see the Pro Test – a better dice control metric section. The report has a section for each of the Pro Test values for this shooter.

- **Number of rolls in Pro Test**: This shows the number of rolls entered for this shooter.

- **Number of Pro passes**: This shows the number of passes entered for this shooter.

- **Pro score**: The Pro Test score for this result. A passing score is 1% or less, which means that there is a 1% chance or less that a random shooter could replicate this result. A result of 50% means the Pro Test result is the random expected value. Scores greater than 50% mean the shooter achieved even less than the expected value (this is bad!). If the score is more than 1%, then a warning is displayed noting that this Pro Test should be disabled, since there is insufficient evidence that the shooter is influencing the dice outcomes for this test.

- **Minimum Pro Test value for a pass**: This shows the smallest
value for this Pro Test that results in a passing score (1% or less) in the specified number of rolls. See the section Pro Test in Practice »Page 37 for more information on how to analyze and improve your Pro Test scores. Note that for Pro 3 Test, we want to minimize the failures, whereas we want to maximize the passes for Pro 1 and 2.

- **Expected Pro Test passes for a random shooter:** This shows the Pro Test result a random shooter is expected to achieve.

- **Actual Pro Test result used:** This value is displayed if you have set the Confidence Interval »Page 83 option for this shooter. The actual Pro Test result used will be weakened (reduced for Pro 1 and 2, increased for Pro 3) so that there is a 95% confidence that the shooter’s actual innate Pro Test skill is this lesser value or better. This conservative approach helps ensure that the player’s edge is not overestimated in the simulations and calculators. Note that the weakened value is never made less than the random expected value. If the confidence interval option is not set for this shooter, then a warning is displayed noting that any edge calculations may be higher than what the shooter can achieve.

If the Pro Test value is not a passing score, then a warning in displayed. But if the result is fairly strong, then the number of rolls required to pass is noted (assuming the same ratio of the result to rolls for Pro 1, and ratio of the result to Pro 1 passes for Pro 2 and 3).
Table Settings

Click the 'Table' button on the main screen to bring up the 'Table spots' dialog.

Smart Craps starts with a craps pit or table, just like a casino does. The table has betting spots where shooters can walk up and bet and/or throw the dice. For a general overview of the simulation structure used in Smart Craps, see the How Smart Craps Works »Page 52 section.

Table betting spots
The main list shows the betting spots that have been defined for the table. These are equivalent to the places around the table where shooters can walkup, place their chips, make bets, and throw the dice. Like a real table, a spot may be occupied by different shooters over time. A shooter filling a spot at the table is a called a walkup in Smart Craps.

To select a spot in the list, make sure you click on the value in the first 'Spot #' column.
**New spot**
Click on this button to create a new empty spot in the table.

**Delete spot**
Click on this button to delete the currently selected spot in the main list. You are prompted to confirm before the spot is removed.

**Edit Spot**
Click on this button to edit the currently selected spot in the main table list.

For a general overview of the simulation structure used in *Smart Craps*, see the How Smart Craps Works »Page 52 section.

To understand the **spot** concept in *Smart Craps*, think of a real casino and how players actually come and go from the tables. Over time, a spot at a table will be occupied by different people, as they play for a while and leave. *Smart Craps* lets you (optionally) simulate the same patterns through table spots.

**Walkups for table spot**
The main list on this dialog shows the walkups you have created for this spot. To select a walkup, click on the value in the first column (not the other columns).
**New walkup**
Click on this button to add a new walkup to this table spot. It is added to the end of the list. The order of the walkups is not relevant, since they are selected randomly when the dice are passed to the spot. Because of this, you cannot change the order of the walkups.

**Delete walkup**
Use this button to delete the currently selected walkup. You will be prompted to confirm the removal before it is done.

**Edit Walkup**
Click on the 'Edit walkup' button to bring up the walkup dialog.

![Edit walkup dialog](image)

**Shooter**
Click on the first drop-down list to specify the shooter type for this walkup position. The list of available and defined shooters is displayed. Note that more than one walkup in one or more spots may use the same shooter. These represent different individuals, but with the same exact skill set and betting patterns. Similarly, a shooter may be defined that is not used in a simulation.

**Frequency**
When the *Smart Craps* simulator moves to a new spot, it looks at the walkups defined for the spot to determine the shooter that will actually fill it. Each walkup has a frequency number, and *Smart Craps* selects randomly from the sum of the frequencies to determine which walkup will take the spot. This allows you to bias the random selection choice
that *Smart Craps* uses. By default, the frequency is set to one, so that each walkup has an equally likelihood of being chosen.

**Roll duration**

Once a walkup fills a position, the next question is how long does the shooter stay. You can specify a certain number of rolls that the shooter will minimally complete. Note that the shooter will always continue playing until the hand is done, even if they exceed the roll duration (i.e. they seven out on a point roll, after which the dice are passed to the next spot). Alternatively, you can specify that once the shooter steps up, they never leave the spot. If this happens, the dice will only pass to the next spot after the shooter sevens out on a point. Then, the shooter will wait until the dice return to them, and they shoot again.

If you want a shooter to stay for exactly one hand (i.e. until they seven out), specify ‘1’ for the roll duration. Since the hand is always completed, this will in effect cause them to stay around for a full hand.

**Bet method**

Just like a real craps table, you can place bets on yourself as well as other players. In *Smart Craps*, you decide how you are going to bet, if at all, on every possible walkup.

- **Do not bet on this shooter:** If this option is selected, this walkup is effectively disabled. When the dice are passed to this spot, *Smart Craps* will not select this shooter. Since you are not betting on this shooter, it would be pointless for the simulation to waste time on this walkup. A different walkup will be selected.

- **Bet the same as this shooter:** If this option is selected, then you will place bets just as this shooter would, based on the betting system they use (see the section Edit Shooters » Page 83 for more information). This is the usual selection for this option, since you typically want to simulate betting on your own shooter skills or otherwise known dice setters.

- **Use alternate betting system:** If this option is selected, then you will bet on this shooter using a different betting system of your own choosing. This option is useful if you want to test betting systems based on unknown shooters. Typically, the betting system would make bets based on the empirical observations of their rolls (i.e. dependent on some metric to assess their dice setting skill). With this option, select the alternate betting method from the available list of betting systems. Note that the shooter’s original betting system will be used to determine the dice sets and throwing influence (if any), and that the alternate betting system is only used to determine the bets you make. The shooter’s betting system bets will be ignored and not placed as well. In effect, the shooter’s
betting system is used to determine the throwing influence on the dice, and the alternate system to determine what bets are made.
Pro Test Dice Set Optimizer

Click on the ‘Dice set optimizer’ button on the main screen to access the Pro Test mathematical dice set optimizer.

In the Pro Test - a better dice control metric »Page 29 section, we saw how we developed a way to determine with statistical certainty whether a dice controller is in fact influencing the dice outcomes. And in the Pro Test Player Edge »Page 45 section, we provided a rough sketch on how to convert a set of Pro Test results into an actual theoretical player edge. The options in the optimizer dialog shown above use the same mathematical techniques to calculate edges.

Once a player has properly established their Pro Test results (see the section Recording Pro Test Roll Sets »Page 41), the Dice Set Optimizer should prove to be the most powerful tool in Smart Craps for dice controllers. It will tell you how much money you can make on average for different bets, and the best possible dice sets to use. These are not calculated through simulation of other empirical methods: this is an exact mathematical conversion of the Pro Test results to
optimal dice sets and player edge. This means that if you can transfer your measured Pro Test dice setting skill to the casino, you will have the player edge calculated by the optimizer.

**Pro Test shooters**
This lists all of the defined shooters that are setup with Pro Test throwing style and results (see the Edit Shooters »Page 83 section). The dice set optimizer only works with Pro Test. Determining your edge with SRR values is done through simulation only in *Smart Craps*.

Make sure you select the shooter with the right underlying Pro Test options. The optimal dice sets and edge are very dependent on the actual Pro Test results.

**Craps odds**
Use this option to specify the craps odds provided. Generally, you will find that the optimal dice sets are not affected by the odds, but your player edge, of course, is affected.

**Dice Sets**
Use the options in this section to calculate the edge for a pass line bet given specific dice sets.

For pass (and don't pass) bets, there are four potential situations that require unique sets: the come out roll, 4 or 10 points, 5 or 9 points, and 6 or 8 points. In each case, using a different dice set could potentially lead to a better player edge. You may wonder why the 4/10, 5/9 and 6/8 are grouped together rather than separated. Due to the way dice are configured with opposing sides summing to seven, the three groupings are mathematically equivalent in terms of outcome distributions. As such, they can be treated exactly the same for edge and dice set optimization.

A dice set fully describes one specific orientation of two dice. The dice set specifies exactly what numbers are on top and on the sides for both dice. For example ‘T3F4’ means the die has a 3 on top and a 4 facing you on the front side. This notation is sometimes shortened in *Smart Craps* to 34. When you have two dice specified, you have a complete dice set notation, such as 24/24 (which is a hardway set). Use the drop down lists to set the dice set for all four situations (8 die sets in total).

How many different dice sets are there? Each die has 6 values, each of which can be rotated four ways to yield 24 different die sets. Hence, for two dice, there are $24 \times 24 = 576$ different dice sets (many of which will be equivalent though). Each dice set is unique only in special groups of 16 or 8 (8 for paired dice sets, such as 13/13, 16 for non-paired sets such as 13/15), and *Smart Craps* determines these equivalent classes
and prunes them out. The total number of unique dice sets is 45 (out of the 576 non-unique dice sets).

**Calculate edge**

Click on this button to compute the expected edge for the selected Pro Test shooter, once you have entered all the dice sets. The edge is calculated using the mathematical technique outlined in the Pro Test Player Edge »Page 45 section.

A detailed report is listed in the 'Results' window. Use the scrollbar to view the complete analysis. The actual pass line edge is listed at the end of the report. The report is broken up into four sections corresponding to each of the four dice set groupings. Following the logic outlined in the Pro Test Player Edge »Page 45 section, the actual probability of each of the 36 dice outcomes is listed, followed by the probabilities for each sum. From these sum probabilities, it is possible to algebraically determine the exact pass line edge.

**Copy dice sets to betting system**

Use this button to copy the current dice sets to a betting system.

Only some betting modules »Page 64 support the copying of the dice sets. The default Flat Betting Module »Page 67 that comes with Smart Craps does support dice set copying.
Select the betting system to have the current optimizer dice sets copied to. Click 'OK', and you will be returned to the Dice Set Optimizer dialog. This is a handy shortcut for copying the best dice sets directly into a betting system without having to enter them by hand.

**Optimize Dice Sets for->**

Click on this button to determine the optimal dice sets for the selected Pro Test shooter. Use the drop down list beside this button to optimize for pass or don't pass bets. The Results window will be filled with a detailed analysis. The end of the report notes the optimal dice sets and player edge for the selected bet. In addition, the optimal dice sets are copied into the 'Dice sets' section above. You can then use the 'Copy dice sets to betting system' button to quickly copy the optimal dice sets to a betting system.

The report is broken up into four sections corresponding to the four dice set groupings. The optimizer cycles through each of the 576 possible dice sets, and lists the top ten sets by expectation (edge). Each die has 6 values, each of which can be rotated four ways to yield 24 different die sets. Hence, for two dice, there are $24 \times 24 = 576$ different dice sets (many of which will be equivalent though). The expectation values reported in each section are not representative by themselves (they represent edges for that outcome only). But, the best expectation for each of the four sections can be combined algebraically to get the actual player edge, which is shown at the end of the report along with a summary of the optimal dice sets.

Depending on the shooter, you may have many dice sets that yield the same best possible edge for some of the four groupings. You can freely choose between any of these dice sets, which may in fact be good cover in the casino for your skill.

Also, dice sets that are identical or reflections of each other are removed from the list. Each dice set is unique only in special groups of 16 or 8 (8 for paired sets, such as 13/13, 16 for non-paired sets such as 13/15), and Smart Craps determines these equivalent classes and prunes them out. The total number of unique dice sets is 45 (out of the 576 non-unique dice sets). Understanding these reflections is another potential way to provide cover in the casino for your dice setting skill. The 16 equivalent dice sets are made up in two groups of 8. First, there are the four z-axis rotations of the dice set, times two since you can then switch the left/right order of the dice. But, if you rotate both dice two faces in the Y axis, this is also an identical set. For example, 62/64 is identical to 65/63. There are an additional 8 equivalent dice sets for these as well, yielding 16 in total.

A name is shown next to the dice set in brackets if the set has a
commonly known moniker.

**Don't bet reports**
Reports when optimizing "don't bets" include player edges computed two different ways. This only applies when the specified odds are not zero (the two reported values will be the same when the odds are zero). To understand this, consider how actual odds bets are made.

Typically, a casino will allow you place odds bets larger than your original don't bet, such that the actual win if you roll a seven on the point is your original wager. For example, if you make a $5 bet on the don't, and then roll a 6, a casino with single odds would allow you place a $6 odds bet. If you roll a seven before the point, then you will win your original $5 don't bet and $5 for the odds bet (not $6).

But the charts you see in most craps books that list the house edge for don't bets typically do not determine their values using this more common implementation of don't bets. Instead, they assume that the odds bet is always the same size as the original wager, even with don't bets, and that the payout is correspondingly reduced. This is very misleading, in that the published edge is lower than what you can actually achieve (albeit at increased bankroll risk).

The Smart Craps report lists both player edges in the analysis report.

Also, pushed bets (12 on the come out roll with a don't bet) are excluded from the edge calculation, as is customary in most house edge charts.

**Results Window**

This window shows the analysis results when you click on the 'Optimize dice set for', 'Calculate edge', and 'Optimal dice sets' buttons. Use the scrollbar to scroll up and down in the report.

All reports start with a detailed summary of the Pro Test shooter values. You can see the Pro Test results the shooter is using, whether they passed, and the actual Pro Test values used, if they selected the default confidence interval reduction (see the Pro Test throw style »Page 84 section). If Pro Test values being used are not passes (i.e. the result yields greater than 1% chance of random occurrence), then the report will contain a warning, and you should be very guarded in assuming that the shooter is capable of achieving the noted player edge over the casino.

**Copy results to clipboard**
Use this button to copy the analysis in the report window to the clipboard. This is useful if you want to study the report in a separate
program or editor. For example, you could copy the results to the clipboard, start Notepad, paste the results, and save them to a file.

Returns/Dice sums

This section of the Optimizer can be used to determine the shooter’s edge for unusual bets (such as proposition bets). Let’s look at placing the 8, for example.

When you place the eight, you are betting that an eight will be rolled before a seven. The bet will pay you 7 to 6 ($7 for every $6 bet) if you roll the eight before the seven. To model this in the optimizer, set the seven to ‘-6’, and the eight to ‘7’. This means you will lose $6 (-6) if the seven is rolled, and win $7 (+7) on the eight. The remaining entries are insignificant, and should be set to zero (statistically, they can be ignored).

After the returns are set for each sum, click on the 'Optimal dice sets' button to generate a complete analysis in the Results windows. The best dice sets for this bet are shown at the bottom of the report. The odds field is not relevant for this feature.
Risk of Ruin Calculators

These very useful tools use tested equations to compute bankroll and risk metrics for ROR. It uses the equations described in Don Schlesinger's book *Blackjack Attack: playing the pro's way* (RGE Publishing), which apply equally in craps. We have tested the generated results of these equations against our ROR simulator in *Smart Craps* to confirm that they generate accurate bankroll and risk values.

The average earnings per round (win rate) and standard deviation are copied from the simulation ran last completed. Make sure you ran it with a sufficient number of rounds to ensure accurate values. You can change the values though (both values are available directly in the report files).

The Risk Of Ruin Calculators in *Smart Craps* are based on the same features in Blackjack Audit. You will notice references to betting units in the dialog. *Smart Craps* does not use betting units, as all data is in simple dollars. Consider any reference to a betting unit to be one dollar.

*Single Barrier ROR Calculator*
The single barrier tab allows you to compute either lifetime or trip ROR values. Lifetime ROR has a single 'bankroll' barrier, with no limit on the number of rounds. Trip ROR uses a single bankroll barrier as well, but adds an additional rounds constraint.

You can either compute the risk of ruin for a given lifetime bankroll (left side), or the lifetime bankroll to maintain a certain level of risk (right side), or trip bankroll risk. Note that all values are in units, not dollars. So, you must multiply the bankroll values by your unit bet size to determine the actual required amount.

Note that the equations underlying the top two dialogs are lifetime risk values. They represent risk assuming an infinite amount number of rounds. To model this in the ROR simulator, you need to set no upper bound, and set the number of rounds/session extremely high (2 to 5 million). Alternatively, you can not set a number of rounds, and simply set the upper bankroll bound very high (i.e. 50000 bet units). Lifetime ROR simulations take a long time to run, since there are no constraints.

Here are the actual equations used in the lifetime ROR calculator:
The variables are as follows:

- \( r \): The percentage risk of ruin (between 0 and 1).
- \( E \): The earning rate per round in bet units.
- \( \beta \): The bankroll in bet units.
- \( \sigma \): The standard deviation per round.

The trip ROR dialogs determine risk given a fixed amount of playing time (in rounds), and a fixed bankroll (in units) or percentage ROR. To determine trip ROR in hours played, simply assume 100 rounds/hour (a common assumed average). Trip ROR is generally much lower than lifetime ROR given since you exclude bankruptcy events that would occur much later in time. This functionality is based on trip ROR equations as published in Don Schlesinger’s book *Blackjack Attack: playing the pro’s way* (RGE Publishing). The equations are generally within 5 to 10% accuracy of the corresponding empirical results in the *Smart Craps* simulator, and increase in accuracy as you increase the bankroll and/or rounds. To model this in the ROR simulator, you need to set no upper bound, set the lower bound to the bankroll, and set the rounds equivalently.

**Double Barrier ROR Calculator**
The double barrier calculator lets you model ROR when you have both a limit on the number of rounds, and an upper goal (as well as a bankroll limit). The double barrier calculator is based on very complex equations discussed in the newly published third edition of Don Schlesinger's book *Blackjack Attack: playing the pro's way* (RGE Publishing). We have confirmed that the equations are within 5% to 10% accuracy of the empirical simulator results.

There are four parameters to the double barrier calculator: goal (which includes the initial bankroll), number of rounds, bankroll, and PReach. PReach is the probability of reaching the stated goal. PROR remains the probability of losing your bankroll. With double barrier simulations, there is also the possibility of not reaching either goal (PNeither), as long as the number of rounds is limited.

The 'Solve for' combo box lists the four parameters. Select the variable that you want to solve for. That field can be left blank and is ignored by the calculator.

Note that the number of rounds can be set to 'unlimited' with the checkbox beside it. This allows you to solve for reaching a goal with no
time constraints.

Once you have specified the necessary three variables in the top fields, click on ‘Solve now’ to calculate the results. The results are displayed in the text box along the bottom.

The equivalent ROR simulations set an upper bound, a lower bound, and a rounds limit. Set the upper bound to the goal minus the bankroll (the ROR simulator models profit, where the calculator models total bankroll), and the lower limit to the bankroll. If you have used an unlimited number of rounds in the calculator, set the simulator the same way.
Pro Test Solver

Click on the ‘Pro Test solver’ button on the main screen to bring up the Pro Test Solver tool. See the Pro Test - a better dice control metric »Page 29 section for more information on Pro Test.

This handy tool can help you determine the required Pro Test results to get passing scores in a specified number of rounds.

**Number of rolls in test**
Enter the number of rolls for the test.

**Solve for**
- **Solve for minimum Pro 1 pass value**: Select the first option to solve for the minimum Pro 1 passing value to get a maximum 1% Pro Test score. The corresponding Pro 2 and 3 passing values will be calculated as well. A small report is displayed in the Results window after you click on the ‘Solve for passing Pro Test Values’ button. Use the scrollbar to view the complete report.

Notice that the percentage of Pro 1 passes compared to rolls goes down as you increase the number of rolls. See the Pro Test in Practice »Page 37 section for more information.
• **Use specified Pro 1 result to solve for Pro 2 and 3:** This option is useful if the shooter did not pass Pro 1, but you still want to know the passing results for Pro 2 and/or 3. It is not uncommon for a dice controller with modest skill to fail Pro 1, but still be able to pass Pro 3 (or Pro 2). This is possible, since passing Pro 2 and 3 is strictly based on the number of Pro 1 passes. If the Pro 1 passes are not far from the expected value, then the passing values for Pro 2 and 3 will be easier.

Enter the number of Pro 1 passes the shooter was able to achieve.
Saving and Opening Settings

You can save and open the current settings from the File menu. All of the current options are saved to a file.

Note that you do not have to save the current settings when you quit Smart Craps. All the current settings are saved automatically and restored when you restart the program. Saving the settings to a separate file is useful if you want to restore a particular configuration.

Note also that you can have as many betting systems »Page 64 and shooters »Page 82 defined as you want, even if the current craps table configuration does not use them.

Open settings
Use this file menu item to open a previously saved set of Smart Craps settings. All of the current settings will be erased and replaced by the options in the file you select. If the current settings have not been saved, you will be prompted before continuing to load the new options file.

The default extension for Smart Craps options files is '.smc'.

Save settings
Use this file menu item to save the current settings to the current saved file name. If the current options have not yet been saved since you started Smart Craps, then this menu item is the same as selecting 'Save settings as…'.

Save settings as
Use this file menu item to save the current settings to a file. This will save all of the current settings, including the simulation, craps, betting, shooter, and table options.
Running Simulations

Click on the ‘Run sim’ button on the main screen after you have set all the options and are ready to run a simulation. For example, load the default example file 'example_05_pro_test_fair_pass_bets.smc', and run the simulation.

![Running Smart Craps simulation](image)

A status dialog is displayed as the simulation is executed.

- **Output file**: This field shows the file name that the report is being sent to. If the file name is very long, you can click on this field and scroll left or right to see the full name.

- **Rounds (x1000)**: The number of rounds completed so far, in thousands, is displayed in this field. For example, in the status dialog above, 11,695,000 rounds have been completed.

- **Expectation**: This is the player edge (or casino advantage). It is the sum of earnings (or losses) divided by the sum of all wagers (including pushed bets). If it is negative, this means the casino has the advantage and it is displayed in red. Otherwise, it is black and reflects an advantage the player has over the casino. In general, it can be interpreted to mean that player will win (or lose) that percentage of each and every bet they make, on average. The expectation is updated as more rounds are completed. The edge will tend to ‘settle down’ to a central value as more rounds are completed.

- **Percentage completed**: This bar provides a rough guide to how much of the simulation has been completed so far. The bar will be completely filled by the time the required number of rounds has
been executed.

- **Estimated time to complete:** This field is updated with the expected amount of time left to complete the simulation. The format is hours:minutes:seconds.

- **Cancel Simulation:** Click on this button to stop the current simulation and return to the main window. The report file is still created, but a warning is included noting that the full number of rounds was not completed.

- **Pause Simulation:** Click on this button to stop the simulation temporarily. This is useful since the craps simulator uses up most of the computer resources, and other tasks will not perform well. After you click this button, you can resume the simulation by clicking on the renamed ‘Restart Simulation’ button.

When the simulation is done running and is not canceled, a completion dialog is displayed.

![Simulation completed dialog](image)

Any important errors or warnings are displayed in the window. If you want to see the complete report, click on the ‘View report’ button. A window will be opened showing the complete simulation report. See the Understanding Simulation Reports »Page 112 section for more information.

You can also bring up the report later on by clicking on the ‘View report’ button on the main screen.
Understanding Simulation Reports

Once a simulation has been completed, you can view the report file by clicking on the ‘View report’ button on the main screen.

![Example report file](example_05_pro_test_fair_pass_bets.txt - Notepad)

Depending on the Simulation settings >Page 56, either a text or HTML file is created. For text reports, Windows ‘Notepad’ is called to view the simulation results file. Your current Internet browser (usually Internet Explorer) is opened for HTML files.

The report file is broken up into two main sections: Simulation Setup, and Simulation Results.

Simulation Setup

This section shows all the simulation settings you have set in Smart Craps for this simulation. They are grouped by craps game, betting, shooters, and table settings.

Since you can have many betting systems and shooters that are not necessarily referenced in a simulation, only the ones you are using in
the simulation are displayed. A summary of each referenced betting system and shooter is provided. The full table layout with spots and walkups is also summarized. Only walkups with betting enabled are displayed.

See the following sections for more details on the settings for each group:

- Craps Settings »Page 59
- Bet Settings »Page 64
- Shooter Settings »Page 82
- Table Settings »Page 91

**Simulation Results**

A detailed statistical analysis of the simulation data is provided in this section.

**Win/Loss rates**

The most important thing gamblers usually want to know is how much money they are going to earn or lose, and how quickly. Expectation (or edge) is the total of all wins and losses divided by the sum of all bets made (including pushed bets, such as don’t bets that start with a 12 on the come out roll). This percentage is the amount of each and every bet made that the shooter should expect to earn (or lose), on average.

In addition, we can see how much we make per throw, betting event, hand, and hour. A ‘hand’ starts when a shooter receives the dice to the time they are passed along (when the seven out).

**Simulation statistics**

This section includes the initial simulation settings »Page 56 from *Smart Craps*, as well as some additional basic data. The actual number of rounds completed can be greater than the number requested, since the simulator always finishes a shooter hand once it starts. Only once the hand (walkup) is completed does the simulator check to see if it’s time to stop or quit (simulation canceled).

**Betting statistics**

This section shows a summary of the actual bets placed in the simulation. Depending on the betting systems used, the variance (the square of the standard deviation) may or may not be zero. Also, if odds are allowed, the bet sizes may change as well. An odds bet is considered a separate bet for the statistics.

Note that the statistics in this section only include the wagers, not the
outcomes. Hence, the standard deviation does not reflect the variance for the shooter’s wins and losses. See the Bankroll Statistics section for the data including wins and losses.

**Bankroll Statistics**
This section shows a summary of the results for all wins and losses. These statistics reflect the actual variance for the player, and are used as input for the Risk of Ruin calculator.

**Dice roll statistics**
This section is included once with results for all shooters, and is then repeated for each individual shooter’s results. If a shooter is referenced more than once in the table spots and walkups, then that data is aggregated together in the individual sections.

The number of outcomes for each of the 11 potential throw results is shown (dice sums 2 to 12). The number actually rolled and the expected total are shown in the first two columns, followed by the difference. The last column, chi square, is a reflection of the difference from the observed and expected random result. The chi square is simply the difference from the expected value squared, divided by the expected value. For a random shooter, the chi square result will be quite small (especially as you increase the number of rounds in the simulation). But skilled dice controllers will have high chi square results, since they influence the dice outcomes.

**Dice outcome statistics**
This section shows the statistics for all 35 individual two-dice outcomes (for all shooters collectively, and each separately). As with the dice roll statistics, controlled shooters will have high chi square results, indicating that they are influencing the outcomes.
Running ROR Simulations

Click on the ‘Run ROR sim’ button to run a Risk of Ruin simulation.

The ROR simulator runs multiple craps sessions, each of which are individual craps simulations. Each session is terminated under different criterion that you enter in this dialog. By repeating a large number of sessions, you can determine your risk of ruin and bankroll requirements.

Another way to determine your ROR and bankroll requirements is to use the ROR Calculators »Page 102. These are equations that approximate your risk of ruin based on the average earnings and standard deviation per betting event. To use the ROR calculators, you have to run a simulation first to get these two parameters. The ROR simulator does not require these settings, and tends to be more accurate than the calculators with low numbers of rounds or bankrolls.

**# of ROR sessions:** Enter the of ROR sessions to run. Increasing this number will give you more accurate ROR results.

**Maximum number of betting events/session:** The maximum number of betting events per session. Once the session reaches this number of betting events, it is terminated. Click the 'no limit' checkbox beside this field to allow the sessions to run with no rounds limits (i.e. until one of the other two termination conditions is met).

**Upper limit:** ROR sessions are terminated when the profit reaches this
amount. Click the 'no limit' checkbox beside this field to allow the sessions to run with no upper limit (i.e. until one of the other two termination conditions is met).

**Lower limit:** ROR sessions are terminated when the losses reach this amount. Click the 'no limit' checkbox beside this field to allow the sessions to run with no lower limit (i.e. until one of the other two termination conditions is met).

Note that unlike normal simulations, ROR termination criteria are checked after every dice throw. Normally, a shooter's hand is always finished before the simulation stops. Allowing the hand to finish could result in inaccurate ROR data, since the termination criteria could be exceeded.

Make sure you specify at least one termination condition for the ROR sessions, otherwise the first session will not terminate. Depending on the values in this dialog, the ROR simulation can run very quickly, or take many hours.

The ROR simulator can be used to test the ROR calculator's accuracy. One thing to watch out for when checking the double barrier ROR calculator is that the goal parameter **includes** the initial bankroll. In the ROR simulator, the profit and loss limits do not. For example, if you wanted to test a double barrier ROR calculator setup with a goal of $2000, initial bankroll of $500, and 3000 rounds, then you would use $1500 for the upper limit, $500 for the lower limit, and 3000 for the maximum betting events.

When you have set the ROR simulation options, click 'Run ROR simulation'.
Depending on the ROR simulation options, the three limit fields will show different values during execution. You can pause and restart the simulation, or cancel completely. When it is done, you can view the results in the report file. The results are added to the end of the current report file (if any). If you run more than one ROR simulation, additional ROR reports will be appended to the output file.

The ROR reports are very extensive, providing statistics for all three of the limit situations and also for all sessions collectively. In addition, both the positive and negative ending bankroll situations are summarized.
Default Example Files

*Smart Craps* includes a number of default example files that show you interesting sample simulation settings.

**Example #1 – Random pass bets**

Load the example file ‘example_01_random_pass_bets.smc’ to see a sample that demonstrates a random shooter. The shooter that is used is set to ‘Random throw style’, and the table has one betting spot with only this shooter enabled as a walkup. The craps game is setup with zero odds. The random shooter is placing pass line bets only.

Click on the ‘Run sim’ button in the main screen to run this simulation and see the results. A status window is displayed as the simulation is executed. The player edge (or house advantage, in this case) is updated on the status window as craps rounds are simulated.

Not surprisingly, even after only 3 million rounds, the expectation (edge) is negative, and is close to the mathematical casino edge of 1.41% for pass line bets (as expected).

**Example #2 – SRR shooter**
Load the example file ‘example_02_srr_pass_bets.smc’ to see a sample that demonstrates a SRR shooter. The only shooter tested in this setup uses the SRR throw style, with a minimum SRR of 5.5, and maximum SRR of 6.5. Pass line bets are tested using the minimum SRR on come out rolls and maximum SRR on point rolls. These are very good SRR values, yielding a player advantage of over 3%.

When you view this report, notice the dice roll statistics section. Since there are far more point rolls than come out rolls, the number of sevens is far below expected, and the other sums are higher. This is not surprising given that we are using the maximum SRR value more often on the throws.

**Example #3 – Expert Pro Test shooter, pass bets**
Load the example file 'example_03_pro_test_expert_pass_bets.smc' to see a sample that demonstrates an expert Pro Test shooter. This shooter passed all three Pro Tests very nicely, in 200 rolls. While it is rare to see such outstanding passes for all three tests in only 200 rolls, this serves as a good example of the potential with Pro Test. While these results are very good, we have seen even higher player edges resulting from even more extraordinary dice control skill.

This expert Pro Test shooter has over a 9% edge using the optimal dice sets for a pass line bet. This factors in a reduction of his Pro Test scores to accommodate the standard 95% confidence interval in his Smart Craps shooter settings.

To see this shooter's Pro Test settings, click on the 'Shooters' button on the main screen, and then double click 'Pro Test, expert - pass bets'. Click on 'Check Pro Test scores' to see the details on this shooter's Pro Test results, and the reduced Pro Test values from the 95% confidence interval.

The dice set optimizer was used to set the optimal dice sets in the shooter’s betting system. If we click on the dice set optimizer and select this shooter, we can see the optimal dice sets.

![Example #4 – Good Pro Test shooter, pass bets](image)

These dice sets are fairly traditional for very skilled shooters. Notice that each situation recommends a different dice set. A single dice set for all situations is not optimal for this shooter.

If we let the simulation run to completion (100 million bets), then we'll see that the simulator generates an edge extremely close to the theoretical value shown in the dice set optimizer.

*Example #4 – Good Pro Test shooter, pass bets*
Load the example file ‘example_04_pro_test_good_pass_bets.smc’ to see a sample that demonstrates a very good Pro Test shooter. The shooter settings show the Pro Test results:

They passed only the Pro 1 Test, but with an amazing score of 0.0007%. In actual empirical tests of dice controllers, we tend to see shooters who pass Pro 1, or one of Pro 2 and 3, but less commonly both. Using the dice set optimizer, this shooter's maximum edge is 4.0968% with pass line bets and zero odds.

Interestingly, the optimal dice sets for this shooter are very different from the 'expert' shooter in example #3. For this 'good' Pro Test shooter, the optimal dice sets for a pass line bet are (duplicates with the same edge removed):

**Come out roll (both sets yield the maximum edge):**

- T2F4/T2F4 (hardway)
- T2F4/T5F3 (all sevens)
4/10 points:
- T1F5/T3F5 (2V-A)
- T1F5/T4F5 (2V-B)

5/9 points:
- T1F3/T1F5 (6 T-B)
- T1F3/T1F2 (6 T-A)

6/8 points:
- T1F3/T5F3 (3V)

Notice that the optimal dice sets for the come out roll and 6/8 point are different. How much difference would using the 'expert' dice sets make? Changing just the come out roll dice set to "don't 68" (13/64) reduces the edge to 1.5251%. Also changing the 6/8 point dice set to the hardway set reduces the total edge to -0.0564%, which means the player is losing to the casino!

To understand how this can be, look more closely at the come out roll dice sets. For the "don't 68" dice set, while it has all sevens on a Pro 2 Test, it yields both a 2 and 12 on a double pitch. The hardway set on the other hand, starts with all sevens on the Pro 2 pass, but never generates a 2 or 12. Yet, if the expert shooter uses the 'all sevens' set instead of "don't 68", their edge goes down slightly to 8.9038%.

Similarly, comparing the 3V dice set and hardway set for the 6/8 point, the expert's hardway set results in four sevens on a double pitch. The 3V dice set only has 2 sevens on a double pitch.

Ultimately, skill in minimizing the double pitches and/or maximizing zero pitches can greatly impact the optimal dice sets a shooter should use, which in turn can mean a big different in profit potential.

*Example #5 – Fair Pro Test shooter, pass bets*

In this example, we used reasonably good Pro Test results, but not critically exceptional values.
The Pro Test scores for Pro 1 and 3 are 0.1224% and 0.9140% respectively, in 300 rolls. The player edge this shooter is able to achieve on pass bets with zero odds is 1.6388%. The optimal dice sets overlap with the shooter in example #4. While the optimal dice set lists are not exactly the same for these two, the former dice set is in this shooter's optimal set.

**Example #6 – Marginal Pro Test shooter, pass bets**

In this example, we used a shooter that only marginally passed Pro 1 in 300 throws (159 Pro 1 Test passes, resulting in a score of 0.1784%). There maximum pass line edge is 0.6211%. The same dice sets as example #3 yields their maximum edge potential. But as the Pro Test scores weaken, you will find that many more dice sets are optimal. For example, both the hardway and all sevens dice sets are optimal for this marginal shooter on the come out roll, which was not true for any of the other examples.

**Example #7 – Fair Pro Test shooter, don't pass bets**

In this example, we used a shooter with a pretty good Pro 1 pass of 57 in 100 throws (only... failed Pro 2 and 3). Using the dice set optimizer for don't pass bets and zero odds, we get a potential maximum edge of 1.3993% with the following dice sets (many duplicates removed):

**Come out roll:**
- T1F3/T1F5 (6 T-B)
- T1F3/T1F2 (6 T-A)

**4/10 points:**
- T1F5/T1F5 (straight 6)
- T1F5/T6F2 (hardway)

**5/9 points:**
• T1F5/T1F5 (don’t 5/9)

6/8 points:

• T1F3/T6F4 (don’t 68)

How much do odds impact our potential earnings as a dice controller? Using the dice set optimizer, we can increase the odds to 5 and see that the maximum edge only goes up to 2.6041% (excluding push bets, but assuming large odds wagers). The difference is about the same as for a random shooter, but whether it’s worth the added risk of ruin and greater bankroll requirements is debatable. We can answer this using the Risk of Ruin calculators.

If we run the simulation example as is without the 5 times odds, we can generate the required information for the ROR calculators. After the simulation finishes, click on the ROR calculator button.
Entering 5 in the lifetime ROR section, we see that we need a $6,445.20 bankroll to have a lifetime 5% risk of ruin. The wager size was $60 (see the craps and bet settings). Close the ROR dialog, and click on the 'Craps' settings button. Change the game odds to 5.

![Craps game settings dialog](image)

Now, when we rerun the simulation, we get an edge of 2.588215% (excluding pushed bets), which is close to the value from the dice set optimizer (not surprisingly). Click on the ROR Calculator button again, and we see that the standard deviation has increased substantially, since we are placing large odds bets.
We get a $14,888.81 bankroll requirement when we solve for the 5% lifetime ROR. As long as you are comfortable with this large bankroll, 5 times odds bets are fine. But a less financed shooter should consider avoiding such large odds bets and be happy with a greater than 1% player edge they get without them.

**Example #8 – Fair Pro Test shooter, place bets**

In this example, we look at testing place bets. Here are the settings for the 'Pro Test, fair - place bets' shooter.
The Pro Test results are the same as example #5, yielding a pass line bet edge of 1.6388%. But we can also test this shooter's ability for placing the 6 or 8. We use the Dice Set Optimizer and set the 'Returns/dice sums' as follows:
On a roll of seven, we would effectively lose $6 and win $7 on the roll of eight. The remaining sums are irrelevant, and we set the return to zero. Clicking on 'Optimal dice set' produces the report shown above. The 3V dice set yields the optimal edge of 1.8215%, which is slightly better than the zero odds pass line bet.

If we run the simulation (100 million rounds), we get an edge of 1.852705%, which closely matches the result from the dice set optimizer.

**Example #9 to #11**
These examples are explained in the section Proving Smart Craps Works » Page 149.

**Example #12 & 13 - Script Betting Module, 5 count, random shooter**
Load these examples to see the Script Betting Module » Page 70 demonstrating Scoblete’s 5 Count betting system. The example references the '5_count.vbs' script that implements a basic version of the 5 count betting system.
Example #12 uses the 5 count on one random shooter. Example #13 uses the 5 count with two shooters (one random, one SRR). Example #13 shows that the 5 count does lead to a positive edge, when there are positive edge shooters at the table. You can experiment by changing the probability of the SRR versus the random shooter.

**Example #14 - Script Betting Module, progression betting**
This example shows a simple script that defines a progression betting system. Each time a betting opportunity comes up on the come out roll, the bankroll is compared to the last time. If the bankroll is higher (i.e. we won the last bet), then we add the table minimum to our bet size. Otherwise if the bankroll is lower (i.e. we lost the last bet), we scale back to the table minimum bet. Only pass line bets are made.

The simulation is setup with one random shooter.
How to Record a Pro Test Roll Set

Before you begin recording a Pro Test roll set, make sure you have read the following sections:

- Pro Test - a better dice control metric »Page 29
- Pro Test in Practice »Page 37
- Recording Pro Test Roll Sets »Page 41

Once you understand what the Pro Test is, and the best conditions for recording roll sets, you can begin. Select 'Pro Test Recording (HTML)' from the Tools menu in Smart Craps. A browser window will open with a sample Pro Test recording sheet. Print off the first 3 or four pages (only! The sample recording sheet has 1000 rows, which is a lot of print pages).
The Notes section is a reminder of how to set and record your throws. Record each throw on one line, in order. When you are done recording throws, you can total and summarize the results in the top section.

Alternatively, if you have Microsoft Excel installed on your Windows desktop computer, you can select the 'Pro Test Recording (Excel)' item from Tools menu. This will bring up Microsoft Excel with a Pro Test Recording sheet.
Just enter the two die rolls for each throw in the 2nd and 3rd columns, and the spreadsheet will take care of the rest. The Pro Test pass/fail columns will be filled automatically, and the summary section updated. This handy spreadsheet has the full power of the Pro Test equations programmed.

In the rolls above, the shooter is showing good evidence of dice control on the Pro 1 Test, but is not yet passing. If they maintained the same ratio of Pro 1 passes (63/127 = 49.6%), then they could pass the Pro 1 test in 550 rolls with 273 Pro 1 passes.
Creating a Simulation and Settings

Suppose that the shooter in the How to Record a Pro Test Roll Set » Page 130 section continued to record throws. They failed the Pro 1 Test with 63 passes out of 127 rolls, which is about a 50% pass rate. Suppose they continued and managed to get 204 Pro 1 passes in 400 rolls (51% pass rate).

To see whether this is a good Pro test result, click on 'Pro Test solver' from the main screen. Enter 400 in the top field, and solve for minimum Pro 1 pass value:

![Pro Test Solver](image)

The minimum Pro 1 Test passes is 202 (in 400 rolls). So, we have good values for evaluating this shooter, since they achieved 204 Pro 1 passes.

Before we begin, let’s clear all the current options. Select 'Clear settings' from the File menu to remove all the current options. If you want to restore the initial options, selecting 'Open settings' from the File menu and load the 'initial_options.smc' file that comes with Smart Craps. Or, save the current settings to a file before clearing them, using the 'Save setting as' File menu item.

Let's start by defining a betting system for this shooter. For the
moment, let's assume they will be making basic pass line bets. Click on 'Betting' from the main screen, and click on 'New system'. Call this system 'test', and use the 'Flat Betting' module. Click OK to return to the Betting Systems dialog, and double click on the 'test' system to edit it.

The default options are good to start with. We don't yet know what the optimal dice sets are, so don't worry about changing these.

Click OK and Close to return to the main screen. The default game options use a minimum bet of $30, and single odds, which you can see if you click on 'Craps' on the main screen.
Click on 'Shooter' to add a Pro Test shooter that corresponds to the results above. Click on 'New shooter', then double click on the new entry to edit it. Set the throw style to 'Pro Test', and enter 400 for the number of rolls, and 204 for the Pro 1 passes.
Clicking on the 'Check Pro Test scores' button, we see that the Pro 1 Test score is 0.4929%, which is under the passing requirement of 1%. Since we wisely did not turn off the confidence interval option, the actual Pro 1 Test result the simulator and calculator will use is 187. This will ensure that the edge results are reasonably possible for this shooter in favorable casino conditions. A random shooter would have gotten $\frac{4}{9} \times 400 = 177$ Pro 1 passes.
Optimizing dice sets

Click on 'Pro Test Dice set optimizer' to see how this shooter will perform. The defaults will test for a pass line bet, with single odds. Click on the 'Optimize dice sets for' button:
Despite having only marginally passed the Pro 1 Test and no others, this shooter’s dice control is sufficient to get a slight positive 0.5015% edge over the casino with single odds, with pass line bets. But to get this edge, they have to use specific dice sets on each situation as shown just prior to the edge in the results window:

**Come out roll:**

1) T2F4/T2F4 (hardway)
6) T2F4/T5F3 (all sevens)

**4/10 points:**

4) T1F5/T3F5 (2V-A)
5) T1F5/T4F5 (2V-B)

**5/9 points:**

1) T1F3/T1F5 (6 T-B)
2) T1F3/T1F2 (6 T-A)

**6/8 points:**
7) T1F3/T5F3 (3V)

The results window actually shows many more dice sets for each situation. With only a marginal Pro 1 pass, it generally follows that many different dice sets yield the same optimal player edge. We've included a few of the more commonly named dice sets above. As you pass more of the Pro Tests with improved values, the number of duplicate optimal dice sets will decrease.

The first optimal displayed dice sets for each situation are copied to the fields in the dialog. Click on the 'Copy dice sets to betting system' button.

The 'test' betting system we created earlier is selected. Click 'OK' to have these optimal dice sets copied now to that betting system. The first entry in each section is copied to the betting system.

If we decrease the odds to zero in the field near the top of the dialog, and click on the 'Optimize dice sets for' button again, we can see that the player edge is -0.0965%: a slight advantage for the casino. But what about don't bets?

Click on the drop down list and switch to optimize for Don't pass bets, then click on the 'Optimize dice sets for' button again. Interestingly, this marginal shooter can get a positive edge with zero odds with don't pass bets (0.4136%). Different dice sets are required though, not surprisingly:
**Come out roll:**

1) T1F3/T1F5 (6 T-B)
2) T1F3/T1F2 (6 T-A)

**4/10 points:**

1) T1F5/T1F5 (straight T-A)
7) T1F5/T6F2 (don't 59)

**5/9 points:**

1) T1F5/T1F5 (straight T-A)

**6/8 points:**

6) T1F3/T6F4 (don't 68)

If we change the odds back to single odds again and optimize again for Don't pass, this shooter can actually get a 1.1358% edge, as long as they follow up with maximum odds bets. The report shows two edge results, the first version is equivalent to the kind of calculation shown in most books. Historically, books calculate the edge for don't pass bets (for random shooters) assuming that the odds bets are the same size as the original wager (and the payout is less, depending on the point). This is not how casinos typically operate, as you are generally allowed to place odds bets larger than your original wager. This is why the 1.1358% edge is a more accurate representation of the player's potential.

Click 'OK' to return to the edit shooters dialog, and Close to return to the main screen. Now, we need to add this shooter to the craps Table and we can run a simulation. Click on the 'Table' button in the main screen. Click 'New spot' then double click the new entry. This brings up the walkup dialog. Click 'New walkup', and double click the new entry to setup the walkup.
The shooter we have created is already selected. We want to bet as if we are this shooter, so there are no further changes required. Click OK and Close to return to the main screen.

**Viewing a simulation report**

Click 'Run sim' on the main screen to see the actual simulation results for our shooter, using pass line bets, $30 bets following with matching single odds bets, and the optimal dice sets we calculated and copied over. The simulation will run 10 million rounds, which is sufficient for a quick test (100 million to 1 billion is better for several decimals of accuracy).

When the simulation is done, click 'View report' and scroll down to the results section.

This shooter can make just over $7.50 an hour with $30 bets on the pass line (and following up with $30 single odds bets), assuming 100
throws an hour (or about 50 independent bets an hour). Of course, a
normal player will not control the dice the whole time, and betting on
other unknown players will most likely hurt their earnings potential.

Scrolling a bit farther down in the report, we can see the outcome
probabilities by sum on the come out roll:

![Dice roll statistics](image)

We ended up using a hardway set for the come out roll (24/24), as
shown earlier in the report. We can see the impact on the dice
outcomes, as the sevens had higher frequency and the 2, 3, and 12
had less frequency. Interestingly, the 11 outcomes were less than
average, which is not desirable, but also not surprising with a hardway
set. But without any Pro 2 or Pro 3 skill, the negatives of other sets that
might also generate 11 outcomes would weaken their overall edge
potential. The Dice Set Optimizer is mathematically perfect, yielding the
best possible dice sets.

**Testing Risk of Ruin**

How much money (or bankroll) would this shooter need to play
comfortably with minimal risk of ruin (ROR)? If we return to the main
screen, we can click the "ROR calculator" button to answer this
question. Suppose we want to know how much money is required for
this shooter to play exactly as described by this simulation for 8 hours,
and have no greater than 5% chance of losing their session bankroll.
We know from the simulation report that about 50 bets were made an
hour (each odds bet is considered a separate $30 bet), so that would
be 8 * 50 = 400 rounds. So we enter 400 for the number of rounds and
5 for the ROR % in the 'Calculate Trip Bankroll' section. Click on the
'Solve for Trip bankroll' button.
## Risk of Ruin Calculators

### Statistics from simulation (in units, not dollars)

<table>
<thead>
<tr>
<th>Earnings per round:</th>
<th>0.154483</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard deviation per round:</td>
<td>32.89354</td>
</tr>
</tbody>
</table>

### Single Barrier vs Double Barrier

**Calculate ROR**

- Bank (units):
- ROR (%):

**Calculate Bankroll**

- Risk of ruin (%):
- Bank (units):

**Calculate Trip ROR**

- # of rounds:
- Bank (units):
- ROR (%):

**Calculate Trip Bankroll**

- # of rounds: 400
- ROR (%): 5
- Bankroll (units): 1240.012

### Solve for ROR

- ![Solve for ROR](image)

### Solve for Bankroll

- ![Solve for Bankroll](image)
This shooter would need about $1,250 to play with no greater than 5% chance of losing this bankroll over 8 hours. This is pretty sobering, as their average win per 8 hour session would only be $7.50 \times 8 = $56.25. Of course, simply increasing their unit bet size will increase their profit potential proportionately, but their bankroll requirements will go up too.

But before we give up completely, suppose this shooter practices his skills for a few more months, and manages to improve his Pro Test results. Let’s say he records an additional 600 rolls, and gets 515 Pro 1 passes (in 1000 rolls), 125 Pro 2 passes, and 103 Pro 3 failures. Edit the shooter, enter these new values, and click on 'Check Pro Test scores'. Here are the results:

Number of rolls in Pro Test: 1000.

**Pro 1 Test summary:**
Now, the shooter has proven with even more certainty that he is influencing the dice outcomes, as evidenced by the 0.0004% Pro 1 Test score. He is not managing to pass Pro 2 Test at all, but he has succeeded in avoiding double pitches by passing Pro 3.

Returning to the Edit Shooter dialog, we can check the 'Pro 2 test failed' option, and click 'Pro Test dice optimizer' to see this shooter's new potential earning power.

Click 'Optimize dice sets for' to determine the edge for the default pass line bets with single odds.
Now, the shooter is achieving a healthy 2.7541% edge over the casino. Let's take a closer look at the optimal dice sets, which have far less duplicates now with the improved Pro Test scores:

**Come out roll:**

4) T2F4/T5F3 (all sevens)

**4/10 points:**

1) T1F5/T3F5 (2V-A)

**5/9 points:**

1) T1F3/T1F2 (6 T-A)

3) T1F3/T5F3 (3V)

**6/8 points:**

1) T1F3/T5F3 (3V)

At first glance, this may appear different from the prior optimal pass line dice sets. But the two dice sets have a common intersection, which shows that they yield the same maximum potential edge. This is
common when comparing optimal dice sets: look carefully before assuming that a change in Pro Test values means a change in optimal dice sets. One way to test this is to enter the explicit dice sets and click on the 'Calculate edge' button. If the edge does not change, the dice sets are both optimal.

While the optimal dice sets do overlap, the actual optimal dice sets that we copied from the previous shooter do not intersect with the new shooter (recall that the first entry for each situation is copied). So, Click on the 'Copy dice sets to betting system' button and copy over the new dice sets before we leave this dialog.

If we return to the main screen and rerun the simulation with these new settings, we get the following results, which closely match the dice set optimizer (and would improve in accuracy if we added more rounds in the simulation):

![Simulation Results](example_08_pro_test_fair_place_bets.txt - Notepad)

The shooter's win rate has improved over 5 times as much as before, to about $40 an hour (with no other changes to the bets or game). Now let's return to the ROR calculator and see what has changed there:
The 8 hour bankroll requirements for a 5% trip ROR is now about $1,025, down slightly from before.

So this shooter's practice and patience has definitely paid off, yielding a fantastic $40 per hour win rate while they are throwing the dice. About $1000 for a single-day bankroll provides acceptable risk of ruin at a 'green chip' level of play (around $25 a bet). Their average theoretical daily profit should be around $300, assuming they can make 50 bets an hours on their own throws. Time to memorize a few of the optimal dice sets for each of the four situations, and hit the casino!
Proving Smart Craps Works

An interesting test you can do with Smart Craps is to simulate Pro Test and SRR shooters with expected random results. When a shooter with exactly expected values is tested, they should produce the same edge as a random player. This is in addition to testing the random throw style to confirm the house edge charts printed in many craps books.

**Random SRR trial**
To see this test, choose 'Open settings' from the File menu, and select the 'example_09_srr_random.smc' settings file. This simulation tests an SRR shooter whose minimum and maximum SRR values are exactly 6.0, which are the random expected values. Pass line bets are tested with zero odds. 1 billion throws are completed when you click on 'Run sim' from the main screen. After the simulation is done, view the report. The player edge is -1.411245%, which is very close to the mathematical result of -1.4141%.

**Random Pro Test trials**
To see this test, choose 'Open settings' from the File menu and select the 'example_10_protest_random.smc' settings file. This simulation uses a Pro Test shooter with 90 rolls, 40 Pro 1 passes, 10 Pro 2 passes, and 10 Pro 3 passes. These are exactly the expected values for a random shooter. 90 rolls was chosen so that the expected random Pro Test values are exact without rounding problems. 1 billion dice throws are completed when you click on 'Run sim' from the main screen. After the simulation is done, view the report. The player edge is -1.410925%, which is very close to the mathematical result of -1.4141%.

Scroll down in the report to the outcome distribution section for dice rolls:
Notice that the chi square values are very small for all sums, which indicates consistently random throws.

The actual dice sets used do not matter when using random Pro Test values. Click on 'Betting' from the main screen, and edit the one betting system. Notice we are using the same dice set option for all throws. Try changing the dice set to any other two settings for both dice. When you re-run the simulation, you'll notice that the final edge is exactly the same as before. This happens since *Smart Craps* determines the probability for all 36 dice outcomes, then randomly chooses from these. Since the probability will be 1/36 across the board in both simulations, the same random sequence of dice rolls will be generated (see the Simulation Settings »Page 56 section for more details on the random number generator).

Load the 'example_11_protest_random.smc' settings file for one more Pro Test example. With this trial, we use the same random expected Pro Test shooter results, but we are testing don't pass bets with 5 times odds.

In the Dice Set Optimizer »Page 96 section, we noted that there are two ways to compute the mathematical edge with odds and don't pass bets. Most house edge charts in published craps books include expectations that assume the odds bet is same size as the original wager. This results in a payout that is less than the original wager. This is not what casinos do in practice: they allow you to wager more than the original wager such that the potential payout is the wager size. The former method of computing the edge with don't odds bets over estimates the casino's advantage, since it does not model the maximum odds wagers (which is to the player's benefit). Also, most
books exclude the pushed bets (on a come roll of 12) from the edge calculation. The edge is the total of winnings and losses divided by the sum of all bets. Excluding the pushed bets lowers the denominator, which increases the house edge for random shooters.

Knowing this, here are the simulation results for the random Pro Test shooter and don't pass bets with five times odds:

![Simulation Results Image]

Most craps books list the house edge as 0.32% for this bet (excluding pushed bets). We can resolve this by clicking on the 'Dice set optimizer' button from the main screen. Switch to optimize for don't pass bets, and click on the 'Optimize dice sets for' button. We get the following results:

**Don't pass bet expectation (small odds bets):**
- exp. = -0.3167%

**Don't pass bet expectation (large odds bets):**
- exp. = -0.2283%

The second expectation, using large odds bets, closely matches the simulation result of -0.229340%. The first number matches the common published house edge of 0.32%.

Another interesting thing to note in the Optimizer report is that all 45 unique dice sets are listed for each situation. This is not surprising, since no dice set is better or worse than any other dice set (see the Dice Set Notation »Page 97 section for more details).
Smart Craps Command Line Options

*Smart Craps* can be completely automated for running from the command line or batch processing. This can be very helpful for testing large numbers of simulations.

The *Smart Craps* executable program is 'smartcraps.exe'. To specify all command line options, simply add the name of the option, followed by a colon (no space), a space, and any parameter values. Separate multiple command line options with a '#' symbol and spaces. For example:

```
smartcraps.exe autorun: # load_file: test_sim.smc # num_rounds: 10000000
```

Conflicting settings farther in the command line take precedence.

**Startup Commands**

`autorun`:
- Automatically runs the simulation after processing the command line. The program is closed afterwards.

`autorun_ror`:
- Automatically runs the ROR simulation after processing the command line. The program is closed afterwards. It will use the current ROR simulation settings.

`load_file: <file>`
- Load the saved settings file `<file>`. You can specify a full path, or the current directory is assumed otherwise. Any command line options after this command will override the corresponding settings.

**ROR Simulation Settings**

See the ROR Simulations »Page 115 section for more information on these options.

`ror_lower_limit: <limit>`
- The dollar limit on negative bankroll (i.e. loss) at which to end the ROR sessions. This value is a positive integer. Use -1 to indicate no limit.

`ror_max_rounds: <rounds>`
• The number of rounds for each session. A round is always a betting event for ROR simulations. The rounds type option in the Simulation Settings »Page 56 is not used. Enter -1 to indicate no limit.

ror_sessions: <sessions>

• The number of ROR sessions.

ror_upper_limit: <limit>

• The dollar limit on positive bankroll (i.e. profit) at which to end the ROR sessions. This value is a positive integer. Enter -1 to indicate no limit.

Simulation Settings

These settings correspond to the options available from the 'Simulation' button on the main screen. See the Simulation Settings »Page 56 section for more details on each corresponding option.

debug_output: <0|1|2>

• 0 means 'no debug output', 1 means 'Yes, first 10000 throws only', and 2 means 'Yes, for all rounds in sim'.

num_rounds: <rounds>

• The number of rounds in the simulation. The rounds is in actual rounds, not in thousands as it is entered in the Simulation Settings dialog.

output_file: <file>

• The output file for the simulation report. If you do not include a path, then the file is placed in current directory.

output_type: <0|1>

• 0 means to output text to the report file. 1 means to output HTML.

random_seed: <seed>

• The random seed for the simulation. Any integer is acceptable.

random_sim: <0|1>

• 0 means 'Each simulation will use a different random sequence'. 1 means 'Use the same random sequence for each simulation'.

replace_file: <0|1>
• 0 means 'Append # to output file name to make it unique'. 1 Means 'Overwrite if output file exists'.

rounds_type: <0|1|2>
• 0 means the rounds in the simulation are 'Throws of the dice'. 1 means 'Hands for each shooter'. 2 means 'Bets placed in sim'.

sim_type: <0|1>
• 0 means this is a normal simulation. 1 mean to run an ROR simulation.

Craps Settings

These settings correspond to the options available from the 'Craps' button on the main screen. See the Craps Settings »Page 59 section for more details on each corresponding option.

table_max: <max|-1>
• The table maximum bet, in whole dollars. Set to -1 for no limit.

table_min: <min>
• The table minimum bet in whole dollars. A value greater than zero.

vig_in_dollars: <0|1>
• 0 means the vig is dollars, 1 means to the nearest 50 cents.

vig_leeway: <leeway>
• The vig leeway, as an integer >= 1.

vig_on_buy: <0|1>
• 0 means no vig when you lose the bet, 1 means you pay the commission when you win or lose the bet.

vig_percent: <percent>
• The commission in percent. The value must be an integer > 0.

odds_allowed: <odds>
• The integer odds in the game, >= 0.

odds_over_max: <0|1>
• 0 means odds bets over the table maximum are not allowed,
1 means they are permitted.

**round_odds: <-1|0|round_num>**

- -1 means round all odds bets down ('down for whole payout'). 0 means do not alter the odds bets at all ('leave as bet'), or an integer >= 1 means round the odds bets up to that value.

**Game Odds**

These settings specify the payout odds for different bets. The format is the same for all of them: *<bet>: <num>*. For example, the standard place 6 and 8 odds of 7 to 6 are represented by 'place_68_odds_from: 7' and 'place_68_odds_to: 6'.

- **any_7_odds_from**
- **any_7_odds_to**
- **any_craps_odds_from**
- **any_craps_odds_to**
- **big_68_odds_from**
- **big_68_odds_to**
- **craps_12_odds_from**
- **craps_12_odds_to**
- **craps_2_odds_from**
- **craps_2_odds_to**
- **craps_3_odds_from**
- **craps_3_odds_to**
- **field_12_odds_from**
- **field_12_odds_to**
- **field_2_odds_from**
- **field_2_odds_to**
- **hard_410_odds_from**
- **hard_410_odds_to**
- **hard_68_odds_from**
- **hard_68_odds_to**
- **place_410_odds_from**
place_410_odds_to
place_59_odds_from
place_59_odds_to
place_68_odds_from
place_68_odds_to
yo_11_odds_from
yo_11_odds_to

**Betting, Shooter, Table Settings**

Specifying any of these options through the command line is not recommended. Instead, Create the simulation, save the setting file, and use the 'load_file' option to run it from the command line.
Simulation Setup Wizard

The simulation setup wizard is simple and fast way to create a basic craps simulation without going through all the settings dialogs in Smart Craps. While this wizard will let you create the most common kinds of simulations, a wealth of additional features are available in the settings and options. Once you are comfortable with the program, you should go beyond the wizard and explore all the options available in the settings dialogs.

The sections below correspond to the individual steps in the wizard.

Game/Simulation options

This step in the wizard is used to set common craps game and simulation options. See Simulation Settings »Page 56 and Craps Settings »Page 59 for more details. Use these links to get more information on specific options.

- Number of rounds »Page 56
- Round by round details »Page 57
- Minimum bet size »Page 59
- Craps odds »Page 59

Number of shooters

Smart Craps lets you have as many or as few shooters at the craps table as you want. After you specify how many shooters are at the table, you will be prompted for details on each shooter.

Shooters - throwing style

Use this wizard step to indicate what kind of throwing style to use for this shooter.

- Random throwing style »Page 83
- SRR dice control »Page 27
- Pro Test dice control »Page 29

Dice control skill

If you have chosen SRR or Pro Test throwing style for this shooter, then you need to specify the generic skill level as well. While both SRR and Pro Test have explicit and precise metrics, this wizard option lets you specify their skill in general terms. A 'marginal' shooter will have a
positive edge just over 0% with zero odds on pass line bets. The remaining skill levels are increasing, with pass line edges as high as 10% in the player's favor.

**Shooters - bets**

The wizard lets you specify one basic bet to assign to this shooter. Note that *Smart Craps* has a range of betting and other options to precisely control more complicated simulations.

- Bet type »Page 67
- Point »Page 67

**Shooters - Pro Test**

For shooters that you have selected the Pro Test throwing style, you need to specify a bit more information on their skill.

- Single dice set »Page 67
- Optimize dice sets »Page 96
Pro Test Wizard

Most dice controllers want to know two things: how much money can I make, and what are the optimal dice sets for different bets. The Pro test wizard is the fastest way to answer these questions. This wizard will guide you step by step through taking a Pro Test, entering your results, choosing a bet, and seeing your edge and optimal dice sets. It will even setup *Smart Craps* so that you can confirm your edge through simulation.

All the steps in the Pro Test wizard are fully documented. Just follow the instructions in each dialog.

For more information about Pro Test, including more technical details, click on these additional links:

- Pro Test - a better dice control metric » Page 29
- Pro Test In Practice » Page 37
- Recording Pro Test Roll Sets » Page 41
- How to Record a Pro Test Roll Set » Page 130
- Pro Test Player Edge » Page 45
- Pro Test Dice Set Optimizer » Page 96
- Pro Test Solver » Page 107
Index

---

.html, 58
.txt, 58

---

3V, 25

---

A

alternate bet method, 94
assistant, 157, 159
automatic odds, 60
axes, 24
axis, 24

---

B

bankroll, 142
bankroll statistics, 114
Bernoulli trial, 31
bet, 158
bet - limits, 59
bet method, 94
bet module, 52, 64
bet odds, 62
bet system name, 66
bet systems, 64
bet with shooter, 94
betting, 64
betting module, 67, 70
betting statistics, 113
betting system, 52
blackjack, 5, 21
Blackjack Audit, 21
Blackjack Counter, 21
Blackjack Expert, 21
Blackjack Mentor, 21
books, 7

---

C

calculation, 45
calculator, 54, 102
calculator - edge, 47
cancel simulation, 110
chi square, 114
command line, 152
commission, 62

---

commission - leeway, 62
confidence, 31, 85
certainty interval, 31, 85
course, 7
craps, 8, 59
Craps simulator, 48
creating a simulation, 133

---

data, 37
debug output, 57
DeepNet, 3
degree of freedom, 34
delete, 66
delete bet system, 66
dependent variable, 34
description, 5
dice control, 5, 24
dice roll statistics, 114
dice set, 5, 96
dice set - notation, 25
dice set - optimal, 47
dice set - optimize, 99
dice set format, 97
dice set notation, 97
dice set optimizer, 96
dice sets - optimize, 137
dice setting, 24
distribution, 27
DOF, 34
don't bets, 100
don't bets - edge, 100
double barrier, 104
double pitch, 29, 46
double pitches, 36

---

E

double pitch, 29, 46
double pitches, 36

---

double pitch, 29, 46
double pitches, 36

---

edge, 45, 47, 98, 110
d edge - calculate, 98
d edge calculator, 47
d edge calculator - proof, 48
deit, 66, 83, 92, 93, 98
d edit shooter, 83
d edit spot, 92
d edit walkup, 93, 98
d errors, 110
example simulation, 133
examples, 118
expectation, 45, 110
face rotations, 29
fail Pro Test, 40
file type, 58
flat betting, 67
flat betting module, 67
Frank Scoblete, 7
frequency - walkup, 93
front/back dice set notation, 97

hand, 52, 57
hardway set, 25
help, 157, 159
how Smart Craps works, 52
how to play, 8
HTML, 58
html files, 112

leeway, 62
limits, 59
loss rate, 113
lower limit, 115

main, 3
main help, 3
mathematical derivation, 48
model, 52
module, 64

name, 66
new, 65
new bet system, 65
notation, 25
notation - dice set, 97
number of rolls, 84
number of rounds, 56
number of shooters, 157

odds, 59, 62
open, 109
optimal dice set, 47
optimal dice sets, 96
optimize dice sets, 99
optimizer, 96, 137
options - command line, 152
output - debug, 57
output file, 57
output file type, 58
overwrite file, 57

Palm OS, 21
pause simulation, 110
payout - uneven, 61
pitch, 29
pitch - double, 36
pitches, 29, 46
player edge, 45, 110
Pocket PC, 21
practice, 37
pro 1 test, 31
pro 2 test, 34
pro 3 test, 36
Pro failures, 84
Pro passes, 84
Pro Test, 29, 37, 41, 107, 158
Pro Test - edge, 45
Pro Test - fail, 40
Pro Test - recording roll sets, 130
Pro Test - wizard, 159
Pro Test confidence interval, 85
Pro Test dice set optimizer, 96
Pro Test report, 89
Pro Test results, 89
Pro Test solver, 37, 107
Pro Test summary, 89
Pro Test wizard, 159
Pro Test, throw style, Pro Test, 84
proof, 48, 149
purchase, 23
random number generator, 58
recording, 41
recording roll sets, 130
registration, 23
rename, 66
rename bet system, 66
replace file, 57
report, 89, 141
reports, 112
returns by dice sum, 101
risk of ruin, 102, 115, 142
roll distribution, 27
roll set, 37, 84
roll sets, 41, 130
rolls, 27
ROR, 142
ROR calculator, 102
ROR equations, 102
ROR simulations, 115
ROR, calculator, 102
ROR, equations, 102
ROR, risk of ruin, 102, 104
rotation, 29
round payout, 60
rounding odds, 60
rounds, 56
run, 110
run sim, 110
running simulations, 110

table, 52, 91
table limits, 59
table settings, 91
text file, 58
text file, 58
textile, 24
throw style, 87
throwing style, 157
tools, 54
trial, 31
trip bankroll, 142
txt files, 112

samples, 118
save, 109
Scoblete, 7
score, 89
script betting, 70
script betting module, 70
settings, 52, 56, 59, 62, 64, 65, 66, 82, 83, 84,
  87, 91, 92, 93, 98, 133
settings - craps, 59
settings - open, 109
settings - save, 109
settings - simulation, 56
settings - summary, 52
setup, 52
setup wizard, 157
seven to rolls ratio, 27
shareware, 23
shooter, 52
shooter settings, 82
shooter type, 157
shooters, 82, 83, 84, 87
simulation, 48, 52, 56
simulation - errors, 110
simulation - pause, 110
simulation - report, 141
simulation - run, 110
simulation - settings, 133
simulation reports, 112
simulations - ROR, 115
simulator, 48
single barrier, 102
single pitch, 29, 46
Smart Craps, 5
smart craps - proof, 149
solve for, 107
solver, 107
spot, 52, 91, 92
SRR, 27, 87
SRR throw style, 87
statistics, 113, 114
summary, 89
systems, 64, 65, 66

uneven payout, 61
upper limit, 115

vbscript, 70
vig, 62
vigorish, 62

walkup, 52, 91, 93, 98
walkup - betting, 94
warnings, 110
web resources, 7
Welcome, 3
win rate, 113, 141
Windows, 21
wizard, 157, 159
wizard - bet, 158
wizard - number of shooter, 157
wizard - Pro Test, 158
wizard - shooter type, 157
wizard - throwing style, 157
works, 52

X axis, 24

Z axis, 24, 29